
êÛÍÓ‚Ó‰ÒÚ‚Ó ÔÓ ˝ÍÒÔÎÛ‡Ú‡ˆËË

iPod
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ç‡˜‡ÎÓ ‡·ÓÚ˚

èÓÁ‰‡‚ÎflÂÏ ‚‡Ò Ò ÔËÓ·ÂÚÂÌËÂÏ ÔÓË„˚‚‡ÚÂÎfl iPod.
éÁÌ‡ÍÓÏ¸ÚÂÒ¸ Ò ˝ÚËÏ ‡Á‰ÂÎÓÏ, ˜ÚÓ·˚ ·˚ÒÚÂÂ Ì‡˜‡Ú¸ ‡·ÓÚÛ
Ò ‚‡¯ËÏ iPod.

iPod ‡·ÓÚ‡ÂÚ ÒÓ‚ÏÂÒÚÌÓ Ò ÔÓ„‡ÏÏÓÈ iTunes Ì‡ ÍÓÏÔ¸˛ÚÂÂ Macintosh ËÎË Ò ÔÓ„‡ÏÏÓÈ

MUSICMATCH Jukebox Ì‡ ÍÓÏÔ¸˛ÚÂÂ Windows PC. àÒÔÓÎ¸ÁÛÈÚÂ iTunes ËÎË MUSICMATCH

Jukebox ‰Îfl ÔÂÂÌÓÒ‡ Ì‡ ÍÓÏÔ¸˛ÚÂ Ë ÒËÒÚÂÏ‡ÚËÁ‡ˆËË ÔÂÒÂÌ ËÁ ‚‡¯ÂÈ

ÍÓÎÎÂÍˆËË ÍÓÏÔ‡ÍÚ-‰ËÒÍÓ‚, ‡ Á‡ÚÂÏ Á‡ÔË¯ËÚÂ ÔÂÒÌË Ì‡ iPod.
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éÒÓ·ÂÌÌÓÒÚË iPod
iPod – ˝ÚÓ Ì‡ÏÌÓ„Ó ·ÓÎ¸¯Â, ˜ÂÏ ÔÓÒÚÓ ÏÛÁ˚Í‡Î¸Ì˚È ÔÓË„˚‚‡ÚÂÎ¸. ë ÔÓÏÓ˘¸˛ iPod ‚˚

ÏÓÊÂÚÂ:
● ı‡ÌËÚ¸ Ú˚Òfl˜Ë ÔÂÒÂÌ ‰Îfl ÔÓÒÎÛ¯Ë‚‡ÌËfl ‚ ÔÛÚË
● ÒÎÛ¯‡Ú¸ ‡Û‰ËÓÍÌË„Ë Ò Audible.com
● ı‡ÌËÚ¸, ÒËÌıÓÌËÁËÓ‚‡Ú¸ Í‡ÎÂÌ‰‡¸ Ë ÍÓÌÚ‡ÍÚÌÛ˛ ËÌÙÓÏ‡ˆË˛, ÒÔËÒÍË ‰ÂÎ Ò ‚‡¯Â„Ó

ÍÓÏÔ¸˛ÚÂ‡
● ı‡ÌËÚ¸ ÚÂÍÒÚÓ‚˚Â Á‡ÏÂÚÍË
● Á‡‚ÂÒÚË ·Û‰ËÎ¸ÌËÍ
● Ë„‡Ú¸ ‚ Ë„˚ Ë Ú.‰.

é·Û˜ÂÌËÂ ‡·ÓÚÂ Ò iPod
èÓ˜ËÚ‡ÈÚÂ ˝ÚÛ „Î‡‚Û, ˜ÚÓ·˚ Ì‡ÒÚÓËÚ¸ iPod Ë ·˚ÒÚÂÂ Ì‡˜‡Ú¸ ÒÎÛ¯‡Ú¸ ÏÛÁ˚ÍÛ. óÚÓ·˚ ÛÁÌ‡Ú¸

ÔÓ‰Ó·ÌÛ˛ ËÌÙÓÏ‡ˆË˛ Ó ‚ÓÒÔÓËÁ‚Â‰ÂÌËË ÏÛÁ˚ÍË Ì‡ iPod Ë ËÒÔÓÎ¸ÁÓ‚‡ÌËË ‰Û„Ëı Â„Ó

‚ÓÁÏÓÊÌÓÒÚÂÈ, Ó·‡ÚËÚÂÒ¸ Í ‡Á‰ÂÎÛ “ê‡·ÓÚ‡ Ò iPod” Ì‡ ÒÚ‡ÌËˆÂ 15.

ç‡˜‡ÎÓ ‡·ÓÚ˚
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óÚÓ ÌÛÊÌÓ, ‰Îfl ÚÓ„Ó ˜ÚÓ·˚ Ì‡˜‡Ú¸
óÚÓ·˚ ‡·ÓÚ‡Ú¸ Ò iPod Ì‡ ÍÓÏÔ¸˛ÚÂÂ Macintosh, ‚‡Ï ÌÂÓ·ıÓ‰ËÏÓ ÒÎÂ‰Û˛˘ÂÂ:
● ÍÓÏÔ¸˛ÚÂ Macintosh ÒÓ ‚ÒÚÓÂÌÌ˚Ï ËÌÚÂÙÂÈÒÓÏ FireWire
● Mac OS X 10.1.4 ËÎË ‚˚¯Â – ‰Îfl ËÒÔÓÎ¸ÁÓ‚‡ÌËfl ÌÂÍÓÚÓ˚ı ÙÛÌÍˆËÈ ÚÂ·ÛÂÚÒfl Mac OS X 10.2

ËÎË ‚˚¯Â
● iTunes 3 (ÔËÎ‡„‡ÂÚÒfl Ì‡ ÍÓÏÔ‡ÍÚ-‰ËÒÍÂ iPod) ËÎË ‚˚¯Â
● iSync 1.0 Ë iCal 1.0.1 ËÎË ‚˚¯Â (‰ÓÔÓÎÌËÚÂÎ¸ÌÓ ‰Îfl ÒËÌıÓÌËÁ‡ˆËË ÍÓÌÚ‡ÍÚÌÓÈ Ë Í‡ÎÂÌ‰‡ÌÓÈ

ËÌÙÓÏ‡ˆËË Ò iPod – ‡·ÓÚ‡ÂÚ ÚÓÎ¸ÍÓ ‚ Mac OS X 10.2 ËÎË ‚˚¯Â)

óÚÓ·˚ ‡·ÓÚ‡Ú¸ Ò iPod Ì‡ ÍÓÏÔ¸˛ÚÂÂ Windows PC, ‚‡Ï ÌÂÓ·ıÓ‰ËÏÓ ÒÎÂ‰Û˛˘ÂÂ:
● ÍÓÏÔ¸˛ÚÂ Windows PC Ò 300 åÉ̂  ËÎË ·ÓÎÂÂ ·˚ÒÚ˚Ï ÔÓˆÂÒÒÓÓÏ 
● 96 å· ÓÔÂ‡ÚË‚ÌÓÈ Ô‡ÏflÚË (128 å· ‰Îfl Windows XP)
● ‚ÒÚÓÂÌÌ‡fl ËÎË ÒÂÚËÙËˆËÓ‚‡ÌÌ‡fl ‰Îfl ËÒÔÓÎ¸ÁÓ‚‡ÌËfl Ò Windows Í‡Ú‡ Ò ËÌÚÂÙÂÈÒÓÏ

FireWire (IEEE 1394) ËÎË ÔÓÚ USB 1.1 ËÎË USB 2.0 Ë ‰ÓÔÓÎÌËÚÂÎ¸Ì˚È Í‡·ÂÎ¸ iPod Dock

Connector – USB 2.0 + FireWire

ÑÎfl ÔÓÎÛ˜ÂÌËfl ‰ÓÔÓÎÌËÚÂÎ¸ÌÓÈ ËÌÙÓÏ‡ˆËË Ó ÒÓ‚ÏÂÒÚËÏ˚ı Í‡Ú‡ı FireWire Ë USB Ë Í‡·ÂÎflı

‰Îfl iPod ÔÓÒÂÚËÚÂ Ò‡ÈÚ www.apple.com/ipod.
● MUSICMATCH Jukebox 7.5 (ÔËÎ‡„‡ÂÚÒfl Ì‡ ÍÓÏÔ‡ÍÚ-‰ËÒÍÂ iPod) ËÎË ‚˚¯Â

Ç‡ÊÌÓ: ÔÂÂ‰ Ì‡˜‡ÎÓÏ ‡·ÓÚ˚ Ò iPod Û·Â‰ËÚÂÒ¸, ˜ÚÓ Û ‚‡Ò ÂÒÚ¸ ‚ÒÂ ÔÂÂ˜ËÒÎÂÌÌÓÂ ‚˚¯Â.

ç‡˜‡ÎÓ ‡·ÓÚ˚
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èÓË„˚‚‡ÚÂÎ¸ iPod ÔÓÒÚ‡‚ÎflÂÚÒfl ‚ ÒÎÂ‰Û˛˘ÂÈ ÍÓÏÔÎÂÍÚ‡ˆËË:

ç‡˜‡ÎÓ ‡·ÓÚ˚

èÓË„˚‚‡ÚÂÎ¸ iPod Ä‰‡ÔÚÂ FireWire
(6 ÍÓÌÚ‡ÍÚÓ‚ Ì‡ 4 ÍÓÌÚ‡ÍÚ‡)

ä‡·ÂÎ¸ iPod Dock Connector – FireWire

ÑÓÍ iPod Dock (Ò ÌÂÍÓÚÓ˚ÏË ÏÓ‰ÂÎflÏË)

ç‡Û¯ÌËÍË Apple Earphones

èÛÎ¸Ú ‰ËÒÚ‡ÌˆËÓÌÌÓ„Ó ÛÔ‡‚ÎÂÌËfl
iPod Remote (Ò ÌÂÍÓÚÓ˚ÏË ÏÓ‰ÂÎflÏË)

Ä‰‡ÔÚÂ ÔËÚ‡ÌËfl

á‡ÏÂ˜‡ÌËÂ. ë ÌÂÍÓÚÓ˚ÏË ÏÓ‰ÂÎflÏË iPod ÔÓÒÚ‡‚ÎflÂÚÒfl ˜ÂıÓÎ (ÌÂ ÓÚÓ·‡ÊÂÌÓ Ì‡ ËÒÛÌÍÂ).
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ç‡ÒÚÓÈÍ‡ iPod ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl ÏÛÁ˚ÍË
ÑÎfl Ì‡ÒÚÓÈÍË iPod ‚‡Ï ÌÛÊÌÓ Á‡fl‰ËÚ¸ ·‡Ú‡Â˛, ÛÒÚ‡ÌÓ‚ËÚ¸ ÔÓ„‡ÏÏÌÓÂ Ó·ÂÒÔÂ˜ÂÌËÂ ‰Îfl

iPod Ë ËÏÔÓÚËÓ‚‡Ú¸ ÔÂÒÌË ËÁ ‚‡¯ÂÈ ÍÓÎÎÂÍˆËË ÏÛÁ˚Í‡Î¸Ì˚ı ÍÓÏÔ‡ÍÚ-‰ËÒÍÓ‚ Ì‡ ‚‡¯

ÍÓÏÔ¸˛ÚÂ. á‡ÚÂÏ ‚˚ ÏÓÊÂÚÂ Á‡ÔËÒ‡Ú¸ ÔÂÒÌË Ì‡ iPod Ë Ì‡˜‡Ú¸ ÒÎÛ¯‡Ú¸ ÏÛÁ˚ÍÛ.

ò‡„ 1. á‡fl‰Í‡ ·‡Ú‡ÂË

èÓ‰ÍÎ˛˜ËÚÂ iPod Í ‡‰‡ÔÚÂÛ iPod Power Adapter Ò ÔÓÏÓ˘¸˛ Í‡·ÂÎfl iPod Ë ‡‰‡ÔÚÂ‡ ÔËÚ‡ÌËfl.

Å‡Ú‡Âfl iPod Á‡flÊ‡ÂÚÒfl Ì‡ 80 ÔÓˆÂÌÚÓ‚ ÔËÏÂÌÓ Á‡ ˜‡Ò Ë ÔÓÎÌÓÒÚ¸˛ Á‡flÊ‡ÂÚÒfl Á‡ 4 ˜‡Ò‡.

ç‡˜‡ÎÓ ‡·ÓÚ˚

ä‡·ÂÎ¸ iPod Dock Connector – FireWire

á‡ÏÂ˜‡ÌËÂ. ÖÒÎË ‚˚ ËÒÔÓÎ¸ÁÛÂÚÂ iPod Ò ÍÓÏÔ¸˛ÚÂÓÏ Macintosh, ‚˚ ÏÓÊÂÚÂ ÔÓÔÛÒÚËÚ¸ ¯‡„ 1;

iPod Á‡flÊ‡ÂÚÒfl ÔË ÔÓ‰ÍÎ˛˜ÂÌËË Í Macintosh.
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ò‡„ 2. ìÒÚ‡ÌÓ‚Í‡ ÔÓ„‡ÏÏÌÓ„Ó Ó·ÂÒÔÂ˜ÂÌËfl

ÇÒÚ‡‚¸ÚÂ ‚ ‰ËÒÍÓ‚Ó‰ ‚‡¯Â„Ó ÍÓÏÔ¸˛ÚÂ‡ ÍÓÏÔ‡ÍÚ-‰ËÒÍ iPod CD ‰Îfl ÛÒÚ‡ÌÓ‚ÍË ÔÓ„‡ÏÏÌÓ„Ó

Ó·ÂÒÔÂ˜ÂÌËfl.

àÌÒÚ‡ÎÎflÚÓ ÛÒÚ‡Ì‡‚ÎË‚‡ÂÚ iTunes (Ì‡ ÍÓÏÔ¸˛ÚÂÂ Macintosh) ËÎË MUSICMATCH Jukebox (Ì‡

ÍÓÏÔ¸˛ÚÂÂ Windows PC) Ë Ù‡ÈÎ Ò ÛÍÓ‚Ó‰ÒÚ‚ÓÏ ÔÓ ˝ÍÒÔÎÛ‡Ú‡ˆËË (ÒÓ‰ÂÊ‡ÌËÂ ˝ÚÓ„Ó ·ÛÍÎÂÚ‡).

ò‡„ 3. àÏÔÓÚ ÏÛÁ˚ÍË Ì‡ ‚‡¯ ÍÓÏÔ¸˛ÚÂ

Ç˚ÔÓÎÌËÚÂ ˝ÚÓÚ ¯‡„, ÂÒÎË ‚˚ Â˘Â ÌÂ Á‡ÔËÒ‡ÎË ÏÛÁ˚ÍÛ Ì‡ ‚‡¯ ÍÓÏÔ¸˛ÚÂ.

ÑÎfl ËÏÔÓÚ‡ ÏÛÁ˚ÍË Ì‡ ÍÓÏÔ¸˛ÚÂ Macintosh:

1. ÇÒÚ‡‚¸ÚÂ ÏÛÁ˚Í‡Î¸Ì˚È ÍÓÏÔ‡ÍÚ-‰ËÒÍ ‚ ‰ËÒÍÓ‚Ó‰ ‚‡¯Â„Ó ÍÓÏÔ¸˛ÚÂ‡. Ä‚ÚÓÏ‡ÚË˜ÂÒÍË Á‡ÔÛÒÚËÚÒfl

ÔÓ„‡ÏÏ‡ iTunes.

2. Ç˚·ÂËÚÂ ÔÛÌÍÚ CD ‚ ÒÔËÒÍÂ iTunes Sources Ë Ì‡ÊÏËÚÂ ÍÌÓÔÍÛ ËÏÔÓÚ‡.

3. èÓ‚ÚÓËÚÂ ˝ÚÛ ÓÔÂ‡ˆË˛ Ò ‰Û„ËÏË ÍÓÏÔ‡ÍÚ-‰ËÒÍ‡ÏË, ÒÓ‰ÂÊ‡˘ËÏË ÔÂÒÌË, ÍÓÚÓ˚Â ‚˚ ıÓÚËÚÂ

ËÏÔÓÚËÓ‚‡Ú¸.

ÑÎfl ÔÓÎÛ˜ÂÌËfl ‰ÓÔÓÎÌËÚÂÎ¸ÌÓÈ ËÌÙÓÏ‡ˆËË Ó· ËÏÔÓÚÂ ÔÂÒÂÌ ‚ iTunes Ë ÒËÒÚÂÏ‡ÚËÁ‡ˆËË ÏÛÁ˚ÍË

Ì‡ ‚‡¯ÂÏ ÍÓÏÔ¸˛ÚÂÂ Á‡ÔÛÒÚËÚÂ iTunes Ë ‚˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ Help -> iTunes Help.

ÑÎfl ËÏÔÓÚ‡ ÏÛÁ˚ÍË Ì‡ ÍÓÏÔ¸˛ÚÂ Windows PC:

1. ÇÒÚ‡‚¸ÚÂ ÏÛÁ˚Í‡Î¸Ì˚È ÍÓÏÔ‡ÍÚ-‰ËÒÍ ‚ ‰ËÒÍÓ‚Ó‰ ‚‡¯Â„Ó ÍÓÏÔ¸˛ÚÂ‡ Ë Á‡ÔÛÒÚËÚÂ

ÔÓ„‡ÏÏÛ MUSICMATCH Jukebox.

2. ç‡ÊÏËÚÂ ÍÌÓÔÍÛ Recorder Ë ÍÌÓÔÍÛ Record.

3. èÓ‚ÚÓËÚÂ ˝ÚÛ ÓÔÂ‡ˆË˛ Ò ‰Û„ËÏË ÍÓÏÔ‡ÍÚ-‰ËÒÍ‡ÏË, ÒÓ‰ÂÊ‡˘ËÏË ÔÂÒÌË, ÍÓÚÓ˚Â ‚˚ ıÓÚËÚÂ

ËÏÔÓÚËÓ‚‡Ú¸.

ç‡˜‡ÎÓ ‡·ÓÚ˚
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ÑÎfl ÔÓÎÛ˜ÂÌËfl ‰ÓÔÓÎÌËÚÂÎ¸ÌÓÈ ËÌÙÓÏ‡ˆËË Ó· ËÏÔÓÚÂ ÔÂÒÂÌ ‚ MUSICMATCH Jukebox

Ë ÒËÒÚÂÏ‡ÚËÁ‡ˆËË ÏÛÁ˚ÍË Ì‡ ‚‡¯ÂÏ ÍÓÏÔ¸˛ÚÂÂ Á‡ÔÛÒÚËÚÂ MUSICMATCH Jukebox Ë ‚˚·ÂËÚÂ

ÔÛÌÍÚ ÏÂÌ˛ Help -> MUSICMATCH Jukebox Help.

ç‡˜‡ÎÓ ‡·ÓÚ˚

èÓÚ FireWire 400

ä‡·ÂÎ¸ iPod Dock Connector – FireWire

ò‡„ 4. èÓ‰ÍÎ˛˜ÂÌËÂ iPod Ë ÔÂÂÒ˚ÎÍ‡ ÏÛÁ˚ÍË

èÓ‰ÍÎ˛˜ËÚÂ iPod Í ‚‡¯ÂÏÛ ÍÓÏÔ¸˛ÚÂÛ Ò ÔÓÏÓ˘¸˛ Í‡·ÂÎfl iPod. Ç˚ Ú‡ÍÊÂ ÏÓÊÂÚÂ ËÒÔÓÎ¸ÁÓ‚‡Ú¸

‰ÓÔÓÎÌËÚÂÎ¸Ì˚È ‰ÓÍ iPod Dock (ÒÏ. ÒÚ‡ÌËˆÛ 38).

èË ÔÓ‰ÍÎ˛˜ÂÌËË iPod Í ‚‡¯ÂÏÛ ÍÓÏÔ¸˛ÚÂÛ ‡‚ÚÓÏ‡ÚË˜ÂÒÍË Á‡ÔÛÒÍ‡ÂÚÒfl ÔÓ„‡ÏÏ‡ iTunes

(Ì‡ ÍÓÏÔ¸˛ÚÂÂ Macintosh) ËÎË MUSICMATCH Jukebox (Ì‡ ÍÓÏÔ¸˛ÚÂÂ Windows PC)

Ë ÔÓËÁ‚Ó‰ËÚÒfl ÔÂÂ‰‡˜‡ ÏÛÁ˚Í‡Î¸Ì˚ı Ù‡ÈÎÓ‚ Ë ÒÔËÒÍÓ‚ ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl ËÁ ‚‡¯ÂÈ

ÏÛÁ˚Í‡Î¸ÌÓÈ ·Ë·ÎËÓÚÂÍË Ì‡ iPod.

èÓÒÎÂ ÓÍÓÌ˜‡ÌËfl ÍÓÔËÓ‚‡ÌËfl Ì‡ iPod ÔÓfl‚ÎflÂÚÒfl ÓÒÌÓ‚ÌÓÂ ÏÂÌ˛.
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ÖÒÎË Ì‡ ‚‡¯ÂÏ ÍÓÏÔ¸˛ÚÂÂ Windows PC ÌÂÚ ÔÓ‰ıÓ‰fl˘Â„Ó ÔÓÚ‡

ÖÒÎË Ì‡ ‚‡¯ÂÏ ÍÓÏÔ¸˛ÚÂÂ ÌÂÚ 6-ÍÓÌÚ‡ÍÚÌÓ„Ó ÔÓÚ‡ FireWire (IEEE 1394), ÂÒÚ¸ ‰Û„ËÂ ÒÔÓÒÓ·˚

ÔÓ‰ÍÎ˛˜ÂÌËfl iPod Í ‚‡¯ÂÏÛ ÍÓÏÔ¸˛ÚÂÛ.
● ÖÒÎË Ì‡ ‚‡¯ÂÏ ÍÓÏÔ¸˛ÚÂÂ ÂÒÚ¸ 4-ÍÓÌÚ‡ÍÚÌ˚È ÔÓÚ FireWire, ËÒÔÓÎ¸ÁÛÈÚÂ ÔËÎ‡„‡ÂÏ˚È ‡‰‡ÔÚÂ

FireWire (6 ÍÓÌÚ‡ÍÚÓ‚ Ì‡ 4 ÍÓÌÚ‡ÍÚ‡).

● ÖÒÎË Ì‡ ‚‡¯ÂÏ ÍÓÏÔ¸˛ÚÂÂ ÂÒÚ¸ ÔÓÚ USB 1.1 ËÎË USB 2.0, ‚˚ ÏÓÊÂÚÂ ÔËÓ·ÂÒÚË Í‡·ÂÎ¸ iPod

Dock Connector – USB 2.0 + FireWire Û ÙËÏ˚ Apple.

á‡ÏÂ˜‡ÌËÂ. èÂÂÒ˚ÎÍ‡ ˜ÂÂÁ ÔÓÚ USB 2.0 ÓÒÛ˘ÂÒÚ‚ÎflÂÚÒfl Ì‡ÏÌÓ„Ó ·˚ÒÚÂÂ, ˜ÂÏ ˜ÂÂÁ ÔÓÚ USB 1.1.

● ÖÒÎË Ì‡ ‚‡¯ÂÏ ÍÓÏÔ¸˛ÚÂÂ ÌÂÚ ÔÓÚ‡ FireWire ËÎË ÔÓÚ‡ USB, ‚˚ ÏÓÊÂÚÂ ÔËÓ·ÂÒÚË

ÒÂÚËÙËˆËÓ‚‡ÌÌÛ˛ ‰Îfl ËÒÔÓÎ¸ÁÓ‚‡ÌËfl Ò Windows Í‡ÚÛ Ò ËÌÚÂÙÂÈÒÓÏ FireWire ËÎË USB 2.0 Ë

ÛÒÚ‡ÌÓ‚ËÚ¸ ÂÂ ‚ ‚‡¯ ÍÓÏÔ¸˛ÚÂ.

ÑÎfl ÔÓÎÛ˜ÂÌËfl ‰ÓÔÓÎÌËÚÂÎ¸ÌÓÈ ËÌÙÓÏ‡ˆËË Ó ÒÓ‚ÏÂÒÚËÏ˚ı Í‡Ú‡ı FireWire Ë USB Ë Í‡·ÂÎflı ‰Îfl

iPod ÔÓÒÂÚËÚÂ Ò‡ÈÚ www.apple.com/ipod.

ç‡˜‡ÎÓ ‡·ÓÚ˚

Ä‰‡ÔÚÂ FireWire (6 ÍÓÌÚ‡ÍÚÓ‚ Ì‡ 4 ÍÓÌÚ‡ÍÚ‡)
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ò‡„ 5. ÇÓÒÔÓËÁ‚Â‰ÂÌËÂ ÏÛÁ˚ÍË

èÓÒÎÂ ÓÍÓÌ˜‡ÌËfl ÍÓÔËÓ‚‡ÌËfl ÔÂÒÂÌ ÓÚÒÓÂ‰ËÌËÚÂ iPod ÓÚ ‚‡¯Â„Ó ÍÓÏÔ¸˛ÚÂ‡. ÑÎfl ÔÓËÒÍ‡ ÌÛÊÌÓÈ

ÔÂÒÌË ËÒÔÓÎ¸ÁÛÈÚÂ ÍÓÎÂÒËÍÓ ÔÓÍÛÚÍË Ë ÍÌÓÔÍÛ Select. á‡ÚÂÏ Ì‡ÊÏËÚÂ ÍÌÓÔÍÛ Play Ë

Ì‡ÒÎ‡Ê‰‡ÈÚÂÒ¸!

ç‡˜‡ÎÓ ‡·ÓÚ˚
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ê‡·ÓÚ‡ Ò iPod

èÓÚ ‰Îfl ÔÛÎ¸Ú‡ ‰ËÒÚ‡ÌˆËÓÌÌÓ„Ó ÛÔ‡‚ÎÂÌËfl
iPod Remote èÓÚ ‰Îfl Ì‡Û¯ÌËÍÓ‚ èÂÂÍÎ˛˜‡ÚÂÎ¸ Hold

äÌÓÔÍ‡ Menu äÌÓÔÍ‡ Play/Pause

äÌÓÔÍ‡
Previous/Rewind

äÌÓÔÍ‡ Next/Fast-forward

äÌÓÔÍ‡ Select

èÓÚ Dock Connector

äÓÎÂÒËÍÓ
ÔÓÍÛÚÍË

ç‡Û¯ÌËÍË
Apple Earphones



16 ê‡·ÓÚ‡ Ò iPod

àÒÔÓÎ¸ÁÓ‚‡ÌËÂ Ó„‡ÌÓ‚ ÛÔ‡‚ÎÂÌËfl iPod
ÑÎfl ‡·ÓÚ˚ Ò ˝Í‡ÌÌ˚Ï ÏÂÌ˛ iPod, ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl ÔÂÒÂÌ, ËÁÏÂÌÂÌËfl Ì‡ÒÚÓÂÍ Ë ÔÓÒÏÓÚ‡

ËÌÙÓÏ‡ˆËË ËÒÔÓÎ¸ÁÛÈÚÂ ÍÌÓÔÍË Ë ÍÓÎÂÒËÍÓ ÔÓÍÛÚÍË. ÑÎfl ‚˚·Ó‡ ÌÛÊÌÓ„Ó ÔÛÌÍÚ‡ ÏÂÌ˛

ËÒÔÓÎ¸ÁÛÈÚÂ ÍÓÎÂÒËÍÓ ÔÓÍÛÚÍË, ‡ Á‡ÚÂÏ Ì‡ÊÏËÚÂ ÍÌÓÔÍÛ Select (‚ ˆÂÌÚÂ iPod). ÑÎfl ‚ÓÁ‚‡Ú‡ Í

ÔÂ‰˚‰Û˘ÂÏÛ ÏÂÌ˛ Ì‡ÊÏËÚÂ ÍÌÓÔÍÛ Menu.

é„‡Ì˚ ÛÔ‡‚ÎÂÌËfl iPod

èÂÂÁ‡ÔÛÒÍ iPod èÂÂ‰‚ËÌ¸ÚÂ ÔÂÂÍÎ˛˜‡ÚÂÎ¸ Hold ‚ ÔÓÚË‚ÓÔÓÎÓÊÌÓÂ

(‰Îfl ÛÒÚ‡ÌÂÌËfl ÌÂÔÓÎ‡‰ÓÍ) ÔÓÎÓÊÂÌËÂ, ‚ÂÌËÚÂ ‚ ËÒıÓ‰ÌÓÂ

ÇÍÎ˛˜ÂÌËÂ iPod ç‡ÊÏËÚÂ Î˛·Û˛ ÍÌÓÔÍÛ

Ç˚ÍÎ˛˜ÂÌËÂ iPod ç‡ÊÏËÚÂ Ë Û‰ÂÊËÚÂ ÍÌÓÔÍÛ Play/Pause

ÇÍÎ˛˜ÂÌËÂ Ë ‚˚ÍÎ˛˜ÂÌËÂ ÔÓ‰Ò‚ÂÚÍË ç‡ÊÏËÚÂ Ë Û‰ÂÊËÚÂ ÍÌÓÔÍÛ Menu ËÎË ‚˚·ÂËÚÂ ÔÛÌÍÚ 

Backlight ‚ ÓÒÌÓ‚ÌÓÏ ÏÂÌ˛

Ç˚·Ó ÔÛÌÍÚ‡ ÏÂÌ˛ èÓÍÛÚËÚÂ ÏÂÌ˛ ‰Ó ÌÛÊÌÓ„Ó ÔÛÌÍÚ‡ Ë Ì‡ÊÏËÚÂ ÍÌÓÔÍÛ Select

ÇÓÁ‚‡Ú ‚ ÔÂ‰˚‰Û˘ÂÂ ÏÂÌ˛ ç‡ÊÏËÚÂ ÍÌÓÔÍÛ Menu

èÓËÒÍ ÔÂÒÌË Ç˚·ÂËÚÂ ÔÛÌÍÚ Playlists ËÎË Browse ‚ ÓÒÌÓ‚ÌÓÏ ÏÂÌ˛

ÇÓÒÔÓËÁ‚Â‰ÂÌËÂ ÔÂÒÌË Ç˚‰ÂÎËÚÂ ÔÂÒÌ˛ Ë Ì‡ÊÏËÚÂ ÍÌÓÔÍÛ Select ËÎË Play/Pause

ÇÓÒÔÓËÁ‚Â‰ÂÌËÂ ‚ÒÂı ÔÂÒÂÌ ‚ ÒÔËÒÍÂ Ç˚‰ÂÎËÚÂ Á‡„ÓÎÓ‚ÓÍ ÒÔËÒÍ‡ (Ì‡ÔËÏÂ, Ì‡Á‚‡ÌËÂ ‡Î¸·ÓÏ‡ 

ËÎË Á‡„ÓÎÓ‚ÓÍ ÒÔËÒÍ‡ ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl) Ë Ì‡ÊÏËÚÂ 

ÍÌÓÔÍÛ Play/Pause
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é„‡Ì˚ ÛÔ‡‚ÎÂÌËfl iPod

àÁÏÂÌÂÌËÂ „ÓÏÍÓÒÚË Ç ˝Í‡ÌÂ Now Playing ËÒÔÓÎ¸ÁÛÈÚÂ ÍÓÎÂÒËÍÓ ÔÓÍÛÚÍË. 

Ç˚ Ú‡ÍÊÂ ÏÓÊÂÚÂ ËÒÔÓÎ¸ÁÓ‚‡Ú¸ ÔÛÎ¸Ú ‰ËÒÚ‡ÌˆËÓÌÌÓ„Ó 

ÛÔ‡‚ÎÂÌËfl iPod Remote (ÔÓÒÚ‡‚ÎflÂÚÒfl Ò ÌÂÍÓÚÓ˚ÏË ÏÓ‰ÂÎflÏË)

‚ Î˛·ÓÏ ˝Í‡ÌÂ

èËÓÒÚ‡ÌÓ‚Í‡ ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl ÔÂÒÌË ç‡ÊÏËÚÂ ÍÌÓÔÍÛ Play/Pause, ÍÓ„‰‡ ÌË Ó‰Ì‡ ÔÂÒÌfl ËÎË ÒÔËÒÓÍ

ÌÂ ‚˚‰ÂÎÂÌ˚

éÚÍÎ˛˜ÂÌËÂ ÍÌÓÔÓÍ iPod ìÒÚ‡ÌÓ‚ËÚÂ ÔÂÂÍÎ˛˜‡ÚÂÎ¸ Hold ‚ ÔÓÎÓÊÂÌËÂ Hold 

(˜ÚÓ·˚ Ëı ÌÂÎ¸Áfl ·˚ÎÓ ÒÎÛ˜‡ÈÌÓ Ì‡Ê‡Ú¸) (‚˚ Û‚Ë‰ËÚÂ Ó‡ÌÊÂ‚Û˛ ÔÓÎÓÒÍÛ)

èÂÂıÓ‰ ‚ Î˛·ÓÂ ÏÂÒÚÓ ÔÂÒÌË Ç ˝Í‡ÌÂ Now Playing Ì‡ÊÏËÚÂ ÍÌÓÔÍÛ Select.

á‡ÚÂÏ ÔÓÍÛÚËÚÂ ÔÂÒÌ˛ ‰Ó Î˛·Ó„Ó ÏÂÒÚ‡

èÂÂıÓ‰ Í ÒÎÂ‰Û˛˘ÂÈ ÔÂÒÌÂ ç‡ÊÏËÚÂ ÍÌÓÔÍÛ Next/Fast-forward

èÂÂÁ‡ÔÛÒÍ ÔÂÒÌË ç‡ÊÏËÚÂ ÍÌÓÔÍÛ Previous/Rewind

ÇÓÒÔÓËÁ‚Â‰ÂÌËÂ ÔÂ‰˚‰Û˘ÂÈ ÔÂÒÌË ç‡ÊÏËÚÂ ÍÌÓÔÍÛ Previous/Rewind ‰‚‡Ê‰˚

Å˚ÒÚ‡fl ÔÂÂÏÓÚÍ‡ ‚ÔÂÂ‰ ç‡ÊÏËÚÂ Ë Û‰ÂÊËÚÂ ÍÌÓÔÍÛ Next/Fast-forward

Å˚ÒÚ‡fl ÔÂÂÏÓÚÍ‡ Ì‡Á‡‰ ç‡ÊÏËÚÂ Ë Û‰ÂÊËÚÂ ÍÌÓÔÍÛ Previous/Rewind
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éÚÍÎ˛˜ÂÌËÂ ÍÌÓÔÓÍ iPod Ò ÔÓÏÓ˘¸˛ ÔÂÂÍÎ˛˜‡ÚÂÎfl Hold
ÖÒÎË ‚˚ ÔÂÂÌÓÒËÚÂ iPod ‚ ‚‡¯ÂÏ Í‡Ï‡ÌÂ Ë ÌÂ ıÓÚËÚÂ ÒÎÛ˜‡ÈÌÓ ‚ÍÎ˛˜ËÚ¸ Â„Ó ËÎË Ì‡Ê‡Ú¸ Ì‡

ÌÂÏ Í‡ÍÛ˛-ÌË·Û‰¸ ÍÌÓÔÍÛ, ‚˚ ÏÓÊÂÚÂ ‰ÂÁ‡ÍÚË‚ËÓ‚‡Ú¸ ÍÌÓÔÍË.
■ ìÒÚ‡ÌÓ‚ËÚÂ ÔÂÂÍÎ˛˜‡ÚÂÎ¸ Hold ‚ ÔÓÎÓÊÂÌËÂ Hold.

èÂÂÏÂÒÚËÚÂ ÔÂÂÍÎ˛˜‡ÚÂÎ¸ Í ˆÂÌÚÛ
(‚˚ Û‚Ë‰ËÚÂ Ó‡ÌÊÂ‚Û˛ ÔÓÎÓÒÍÛ),
˜ÚÓ·˚ ÓÚÍÎ˛˜ËÚ¸ ÍÌÓÔÍË iPod.
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ëÓÁ‰‡ÌËÂ Ó˜ÂÂ‰Ë ÔÂÒÂÌ
Ç˚ ÏÓÊÂÚÂ ‚ÓÒÔÓËÁ‚Ó‰ËÚ¸ Ì‡ iPod ÚÂ ÔÂÒÌË, ÍÓÚÓ˚Â ıÓÚËÚÂ, Ë ‚ ÚÓÏ ÔÓfl‰ÍÂ, ‚ Í‡ÍÓÏ ıÓÚËÚÂ.

èÓÒÚ‡‚ÎÂÌÌ˚Â ‚ Ó˜ÂÂ‰¸ ÔÂÒÌË Á‡ÌÓÒflÚÒfl ‚Ó ‚ÂÏÂÌÌ˚È ÒÔËÒÓÍ ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl

Temporary ‚ ÏÂÌ˛ Playlists.

óÚÓ·˚ ÒÓÁ‰‡Ú¸ Ó˜ÂÂ‰¸ ÔÂÒÂÌ:

1. Ç˚‰ÂÎËÚÂ ÔÂÒÌ˛, Ì‡ÊÏËÚÂ ÍÌÓÔÍÛ Select Ë Û‰ÂÊË‚‡ÈÚÂ ÂÂ ‰Ó ÚÂı ÔÓ, ÔÓÍ‡ Ì‡Á‚‡ÌËÂ ÔÂÒÌË ÌÂ

Ì‡˜ÌÂÚ ÏË„‡Ú¸.

2. èÓ‚ÚÓËÚÂ ¯‡„ 1 ‰Îfl ÚÂı ÔÂÒÂÌ, ÍÓÚÓ˚Â ‚˚ ıÓÚËÚÂ ‰Ó·‡‚ËÚ¸ ‚ Ó˜ÂÂ‰¸.

3. Ç˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ Playlists -> Temporary ‰Îfl ÔÓÒÏÓÚ‡ ‚ÒÂı ÔÂÒÂÌ ‚ ‚‡¯ÂÈ Ó˜ÂÂ‰Ë.

Ç˚ Ú‡ÍÊÂ ÏÓÊÂÚÂ ÒÓÁ‰‡‚‡Ú¸ Ó˜ÂÂ‰¸ ËÁ ˆÂÎ˚ı ÒÔËÒÍÓ‚. ç‡ÔËÏÂ, ˜ÚÓ·˚ ÔÓÒÚ‡‚ËÚ¸ ‚ Ó˜ÂÂ‰¸

‡Î¸·ÓÏ, ‚˚‰ÂÎËÚÂ Ì‡Á‚‡ÌËÂ ‡Î¸·ÓÏ‡, Ì‡ÊÏËÚÂ ÍÌÓÔÍÛ Select Ë Û‰ÂÊË‚‡ÈÚÂ ÂÂ ‰Ó ÚÂı ÔÓ, ÔÓÍ‡

Ì‡Á‚‡ÌËÂ ‡Î¸·ÓÏ‡ ÌÂ Ì‡˜ÌÂÚ ÏË„‡Ú¸.

óÚÓ·˚ Ó˜ËÒÚËÚ¸ Ó˜ÂÂ‰¸ ÔÂÒÂÌ:
■ Ç˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ Playlists -> Temporary -> Clear Playlist.

êÂÈÚËÌ„ ÔÂÒÂÌ
Ç˚ ÏÓÊÂÚÂ ÔËÔËÒ‡Ú¸ ÂÈÚËÌ„ ÔÂÒÌÂ (ÓÚ 1 ‰Ó 5 Á‚ÂÁ‰), ˜ÚÓ·˚ ÛÍ‡Á‡Ú¸, Ì‡ÒÍÓÎ¸ÍÓ ÓÌ‡ ‚‡Ï

Ì‡‚ËÚÒfl. êÂÈÚËÌ„Ë ÔÂÒÂÌ ÏÓÊÌÓ ËÒÔÓÎ¸ÁÓ‚‡Ú¸ ‰Îfl ‡‚ÚÓÏ‡ÚË˜ÂÒÍÓ„Ó ÒÓÁ‰‡ÌËfl ÒÔËÒÍÓ‚ ‰Îfl

‚ÓÒÔÓËÁ‚Â‰ÂÌËfl ‚ iTunes (ÒÏ. ‡Á‰ÂÎ “é ÒÔËÒÍ‡ı Smart Playlist” Ì‡ ÒÚ‡ÌËˆÂ 24).

óÚÓ·˚ ÔËÔËÒ‡Ú¸ ÂÈÚËÌ„ ÔÂÒÂÌ:

1. ç‡˜ÌËÚÂ ‚ÓÒÔÓËÁ‚Â‰ÂÌËÂ ÔÂÒÌË.

2. Ç ˝Í‡ÌÂ Now Playing ‰‚‡Ê‰˚ Ì‡ÊÏËÚÂ ÍÌÓÔÍÛ Select.

3. àÒÔÓÎ¸ÁÛÈÚÂ ÍÓÎÂÒËÍÓ ÔÓÍÛÚÍË ‰Îfl ‚˚·Ó‡ ÂÈÚËÌ„‡.
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èÓ‰ÍÎ˛˜ÂÌËÂ Ë ÓÚÍÎ˛˜ÂÌËÂ iPod
Ç‡ÊÌÓ: ÂÒÎË ‚ ‰‡ÌÌ˚È ÏÓÏÂÌÚ ÓÚÍÎ˛˜ËÚ¸ iPod ÌÂ·ÂÁÓÔ‡ÒÌÓ, Ì‡ ˝Í‡ÌÂ iPod ÓÚÓ·‡Ê‡ÂÚÒfl

ÒÓÓ·˘ÂÌËÂ Do not disconnect. çÂ ÓÚÍÎ˛˜‡ÈÚÂ iPod, ÂÒÎË ‚˚ ‚Ë‰ËÚÂ ˝ÚÓ ÒÓÓ·˘ÂÌËÂ. Ç˚ ÏÓÊÂÚÂ

ÔÓ‚Â‰ËÚ¸ Ù‡ÈÎ˚ Ì‡ iPod. ÖÒÎË ‚ ‰‡ÌÌ˚È ÏÓÏÂÌÚ ÏÓÊÌÓ ÓÚÍÎ˛˜ËÚ¸ iPod ÓÚ ‚‡¯Â„Ó

ÍÓÏÔ¸˛ÚÂ‡, ‚ ÓÒÌÓ‚ÌÓÏ ÏÂÌ˛ iPod ÔÓfl‚ÎflÂÚÒfl ·ÓÎ¸¯‡fl ËÍÓÌÍ‡ Ò ·‡Ú‡ÂÂÈ.

óÚÓ·˚ ÔÓ‰ÍÎ˛˜ËÚ¸ iPod Í ‚‡¯ÂÏÛ ÍÓÏÔ¸˛ÚÂÛ:
■ èÓ‰ÍÎ˛˜ËÚÂ Í‡·ÂÎ¸ iPod Í ‚‡¯ÂÏÛ ÍÓÏÔ¸˛ÚÂÛ Ë Í iPod.
■ àÎË ÂÒÎË Û ‚‡Ò ÂÒÚ¸ ‰ÓÍ iPod Dock (ÒÏ. ÒÚ‡ÌËˆÛ 38), ÔÓ‰ÍÎ˛˜ËÚÂ Í‡·ÂÎ¸ iPod Í ‚‡¯ÂÏÛ

ÍÓÏÔ¸˛ÚÂÛ Ë Í ‰ÓÍÛ. á‡ÚÂÏ ÔÓÏÂÒÚËÚÂ iPod ‚ ‰ÓÍ.

èÓ ÛÏÓÎ˜‡ÌË˛ iPod ‡‚ÚÓÏ‡ÚË˜ÂÒÍË Ì‡˜ËÌ‡ÂÚ ËÏÔÓÚËÓ‚‡Ú¸ ÔÂÒÌË ÔË ÔÓ‰ÍÎ˛˜ÂÌËË Í

ÍÓÏÔ¸˛ÚÂÛ. äÓ„‰‡ ˝ÚÓ ‡‚ÚÓÏ‡ÚË˜ÂÒÍÓÂ ÍÓÔËÓ‚‡ÌËÂ ·Û‰ÂÚ Á‡‚Â¯ÂÌÓ, ÏÓÊÌÓ ÓÚÍÎ˛˜ËÚ¸ iPod ÓÚ

ÍÓÏÔ¸˛ÚÂ‡.

ÖÒÎË ‚˚ Ì‡ÒÚÓËÎË iPod ‰Îfl ÔÂÂÒ˚ÎÍË ÔÂÒÂÌ ‚Û˜ÌÛ˛ (ÒÏ. ÒÚ‡ÌËˆÛ 26) ËÎË Ì‡ÒÚÓËÎË iPod ‰Îfl

ËÒÔÓÎ¸ÁÓ‚‡ÌËfl ‚ Í‡˜ÂÒÚ‚Â ÊÂÒÚÍÓ„Ó ‰ËÒÍ‡ (ÒÏ. ÒÚ‡ÌËˆÛ 33), ‚˚ ‰ÓÎÊÌ˚ ‚˚ÔÓÎÌËÚ¸ Ì‡

ÍÓÏÔ¸˛ÚÂÂ ÓÔÂ‡ˆË˛ “‚˚·ÓÒ‡” iPod, ÔÂÂ‰ ÚÂÏ Í‡Í ÓÚÍÎ˛˜ËÚ¸ Â„Ó.
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ÑÎfl “‚˚·ÓÒ‡” iPod Ì‡ ÍÓÏÔ¸˛ÚÂÂ Macintosh:
■ Ç˚·ÂËÚÂ iPod ‚ ÒÔËÒÍÂ iTunes Source Ë Ì‡ÊÏËÚÂ ÍÌÓÔÍÛ Eject.

Ç˚ Ú‡ÍÊÂ ÏÓÊÂÚÂ ÔÂÂÚ‡˘ËÚ¸ ËÍÓÌÍÛ iPod Ì‡ ‡·Ó˜ÂÏ ÒÚÓÎÂ ‚ äÓÁËÌÛ, ˜ÚÓ·˚ “‚˚·ÓÒËÚ¸” Â„Ó.

ÑÎfl “‚˚·ÓÒ‡” iPod Ì‡ ÍÓÏÔ¸˛ÚÂÂ Windows PC:

1. Ç MUSICMATCH Jukebox ‚˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ File -> Send to a portable device.

2. Ç˚·ÂËÚÂ iPod ‚ ÒÔËÒÍÂ Source Ë Ì‡ÊÏËÚÂ ÍÌÓÔÍÛ Eject.

Ç˚ Ú‡ÍÊÂ ÏÓÊÂÚÂ ˘ÂÎÍÌÛÚ¸ Ô‡‚ÓÈ ÍÌÓÔÍÓÈ Ï˚¯Ë Ì‡ ËÍÓÌÍÂ iPod ‚ Windows Explorer ‰Îfl

“‚˚·ÓÒ‡” iPod.

ëËÒÚÂÏ‡ÚËÁËÓ‚‡ÌËÂ Ë ÔÂÂÌÓÒ ‚‡¯ÂÈ ÏÛÁ˚ÍË
ÑÎfl ÔÓÎÛ˜ÂÌËfl ËÌÒÚÛÍˆËÈ Ó ÚÓÏ, Í‡Í ‚ÓÒÔÓËÁ‚Ó‰ËÚ¸ ÏÛÁ˚ÍÛ Ì‡ iPod, Ó·‡ÚËÚÂÒ¸ Í ‡Á‰ÂÎÛ

“ç‡ÒÚÓÈÍ‡ iPod ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl ÏÛÁ˚ÍË” Ì‡ ÒÚ‡ÌËˆÂ 9. Ñ‡ÎÂÂ ‚˚ Ì‡È‰ÂÚÂ

‰ÓÔÓÎÌËÚÂÎ¸ÌÛ˛ ËÌÙÓÏ‡ˆË˛ Ó ÚÓÏ, Í‡Í ÒËÒÚÂÏ‡ÚËÁËÓ‚‡Ú¸ Ë ÔÂÂÌÓÒËÚ¸ ‚‡¯Û ÏÛÁ˚ÍÛ.

é ÔÓ„‡ÏÏ‡ı iTunes Ë MUSICMATCH Jukebox
iTunes (‰Îfl Macintosh) Ë MUSICMATCH Jukebox (‰Îfl Windows PC) - ˝ÚÓ ÏÛÁ˚Í‡Î¸Ì˚Â

ÔËÎÓÊÂÌËfl, ÍÓÚÓ˚Â ËÒÔÓÎ¸ÁÛ˛ÚÒfl ‰Îfl ÔÂÂÌÓÒ‡ ÏÛÁ˚ÍË Ì‡ iPod Ë ‡·ÓÚ˚ Ò ÏÛÁ˚ÍÓÈ Ì‡ iPod.

èË ÔÓ‰ÍÎ˛˜ÂÌËË iPod Í ÍÓÏÔ¸˛ÚÂÛ ÔÓ„‡ÏÏ‡ iTunes ËÎË MUSICMATCH Jukebox Á‡ÔÛÒÍ‡ÂÚÒfl

‡‚ÚÓÏ‡ÚË˜ÂÒÍË.

iTunes MUSICMATCH Jukebox
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ë ÔÓÏÓ˘¸˛ iTunes Ë MUSICMATCH Jukebox ‚˚ Ú‡ÍÊÂ ÏÓÊÂÚÂ ÒËÒÚÂÏ‡ÚËÁËÓ‚‡Ú¸ Ë ÒÎÛ¯‡Ú¸ ‚Ò˛

‚‡¯Û ÏÛÁ˚ÍÛ Ì‡ ‚‡¯ÂÏ ÍÓÏÔ¸˛ÚÂÂ. ÇÓÚ ÌÂÒÍÓÎ¸ÍÓ ÔËÏÂÓ‚ ÚÓ„Ó, ˜ÚÓ ‚˚ ÏÓÊÂÚÂ ‰ÂÎ‡Ú¸ Ò

ÔÓÏÓ˘¸˛ ˝ÚËı ÔËÎÓÊÂÌËÈ:
● ÒÎÛ¯‡Ú¸ ÏÛÁ˚Í‡Î¸Ì˚Â ÍÓÏÔ‡ÍÚ-‰ËÒÍË
● ‰Ó·‡‚ÎflÚ¸ ÏÛÁ˚ÍÛ Ò ÍÓÏÔ‡ÍÚ-‰ËÒÍÓ‚ ‚ ‚‡¯Û ÏÛÁ˚Í‡Î¸ÌÛ˛ ·Ë·ÎËÓÚÂÍÛ, ˜ÚÓ·˚ ÌÂ ‚ÒÚ‡‚ÎflÚ¸

ÍÓÏÔ‡ÍÚ-‰ËÒÍ ‚ ‰ËÒÍÓ‚Ó‰ ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl ÏÛÁ˚ÍË
● Ó„‡ÌËÁÓ‚˚‚‡Ú¸ ÔÂÒÌË ‚ ÒÔËÒÍË ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl
● ÒÓÁ‰‡‚‡Ú¸ ÒÓ·ÒÚ‚ÂÌÌ˚Â ÏÛÁ˚Í‡Î¸Ì˚Â ÍÓÏÔ‡ÍÚ-‰ËÒÍË (ÂÒÎË ‚‡¯ ÍÓÏÔ¸˛ÚÂ ÒÌ‡·ÊÂÌ

ÓÔÚË˜ÂÒÍËÏ CD-RW-‰ËÒÍÓ‚Ó‰ÓÏ)
● ÒÎÛ¯‡Ú¸ ‡‰ËÓÒÚ‡ÌˆËË ‚ àÌÚÂÌÂÚ

Ñ‡ÌÌ˚È ·ÛÍÎÂÚ Ó·˙flÒÌflÂÚ, Í‡Í ÔÂÂÌÓÒËÚ¸ ÔÂÒÌË Ì‡ iPod Ë ‡·ÓÚ‡Ú¸ Ò ÔÂÒÌflÏË Ì‡ iPod Ò

ÔÓÏÓ˘¸˛ ÔÓ„‡ÏÏ˚ iTunes ËÎË MUSICMATCH Jukebox. ÑÎfl ÔÓÎÛ˜ÂÌËfl ËÌÙÓÏ‡ˆËË Ó ‰Û„Ëı

ÙÛÌÍˆËflı ˝ÚËı ÔËÎÓÊÂÌËÈ Á‡ÔÛÒÚËÚÂ iTunes Ë ‚˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ Help -> iTunes Help ËÎË

Á‡ÔÛÒÚËÚÂ MUSICMATCH Jukebox Ë ‚˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ Help -> MUSICMATCH Jukebox Help.

éÚÍÎ˛˜ÂÌËÂ ‡‚ÚÓÏ‡ÚË˜ÂÒÍÓ„Ó Á‡ÔÛÒÍ‡ iTunes ËÎË MUSICMATCH Jukebox

ÑÎfl ÓÚÍÎ˛˜ÂÌËfl ‡‚ÚÓÏ‡ÚË˜ÂÒÍÓ„Ó Á‡ÔÛÒÍ‡ iTunes ÔË ÔÓ‰ÍÎ˛˜ÂÌËË iPod Í ÍÓÏÔ¸˛ÚÂÛ

Macintosh:

1. Ç iTunes ‚˚·ÂËÚÂ iPod ‚ ÒÔËÒÍÂ Source.

2. ç‡ÊÏËÚÂ ÍÌÓÔÍÛ Options Ë ÒÌËÏËÚÂ ÙÎ‡ÊÓÍ Open iTunes when attached.
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ÑÎfl ÓÚÍÎ˛˜ÂÌËfl ‡‚ÚÓÏ‡ÚË˜ÂÒÍÓ„Ó Á‡ÔÛÒÍ‡ MUSICMATCH Jukebox ÔË ÔÓ‰ÍÎ˛˜ÂÌËË iPod

Í ÍÓÏÔ¸˛ÚÂÛ Windows PC:

1. Ç MUSICMATCH Jukebox ‚˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ File -> Send to a portable device.

2. Ç˚·ÂËÚÂ iPod ‚ ÒÔËÒÍÂ Source Ë Ì‡ÊÏËÚÂ ÍÌÓÔÍÛ Options.

3 . ôÂÎÍÌËÚÂ ÔÓ ‚ÍÎ‡‰ÍÂ iPod Ë ÒÌËÏËÚÂ ÙÎ‡ÊÓÍ Automatically launch MUSICMATCH Jukebox on

device connection.

é ÒÔËÒÍ‡ı ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl
ê‡·ÓÚ‡fl ‚ iTunes ËÎË MUSICMATCH Jukebox, ‚˚ ÏÓÊÂÚÂ Ó„‡ÌËÁÓ‚˚‚‡Ú¸ ÔÂÒÌË ‚ ÒÔËÒÍË ‰Îfl

‚ÓÒÔÓËÁ‚Â‰ÂÌËfl. ç‡ÔËÏÂ, ‚˚ ÏÓÊÂÚÂ ÒÓÁ‰‡Ú¸ ÒÔËÒÓÍ Ò ÔÂÒÌflÏË, ÍÓÚÓ˚Â ·Û‰ÂÚÂ ÒÎÛ¯‡Ú¸ ‚Ó

‚ÂÏfl ÛÔ‡ÊÌÂÌËÈ ËÎË Ò ÔÂÒÌflÏË ‰Îfl ÒÓÓÚ‚ÂÚÒÚ‚Û˛˘Â„Ó Ì‡ÒÚÓÂÌËfl.

Ç˚ ÏÓÊÂÚÂ ÒÓÁ‰‡Ú¸ ÒÍÓÎ¸ÍÓ Û„Ó‰ÌÓ ÒÔËÒÍÓ‚ ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl, ‚˚·Ë‡fl Î˛·˚Â ÔÂÒÌË ËÁ

ÏÛÁ˚Í‡Î¸ÌÓÈ ·Ë·ÎËÓÚÂÍË Ì‡ ‚‡¯ÂÏ ÍÓÏÔ¸˛ÚÂÂ. èÓÏÂ˘ÂÌËÂ ÔÂÒÌË ‚ ÒÔËÒÓÍ ‰Îfl

‚ÓÒÔÓËÁ‚Â‰ÂÌËfl ÌÂ ÔË‚Ó‰ËÚ Í ÂÂ Û‰‡ÎÂÌË˛ ËÁ ·Ë·ÎËÓÚÂÍË.

èË ÔÓ‰ÍÎ˛˜ÂÌËË Ë Ó·ÌÓ‚ÎÂÌËË iPod, ÒÔËÒÍË ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl ÔÂÂÌÓÒflÚÒfl Ì‡ iPod.  ÑÎfl

ÔÓÒÏÓÚ‡ ÒÔËÒÍÓ‚ ‚˚·ÂËÚÂ ÔÛÌÍÚ Playlists ‚ ÓÒÌÓ‚ÌÓÏ ÏÂÌ˛ iPod.
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é ÒÔËÒÍ‡ı Smart Playlist
ÖÒÎË ‚˚ ËÒÔÓÎ¸ÁÛÂÚÂ iTunes 3 ËÎË ‚˚¯Â (‚ Mac OS X), ‚˚ ÏÓÊÂÚÂ ‡‚ÚÓÏ‡ÚË˜ÂÒÍË ÒÓÁ‰‡‚‡Ú¸

ÒÔËÒÍË Smart Playlist ËÁ ÔÂÒÂÌ ‚‡¯ÂÈ ·Ë·ÎËÓÚÂÍË. Ç˚ ÏÓÊÂÚÂ ÒÓÁ‰‡Ú¸ ÒÔËÒÓÍ Smart Playlist ËÁ

ÔÂÒÂÌ ÚÓÎ¸ÍÓ ÓÔÂ‰ÂÎÂÌÌÓ„Ó Ê‡Ì‡, ÔÂÒÂÌ ÓÔÂ‰ÂÎÂÌÌ˚ı ËÒÔÓÎÌËÚÂÎÂÈ ËÎË ÔÂÒÂÌ,

ÒÓÓÚ‚ÂÚÒÚ‚Û˛˘Ëı ÓÔÂ‰ÂÎÂÌÌ˚Ï ÍËÚÂËflÏ. ç‡ÔËÏÂ, ‚˚ ÏÓÊÂÚÂ ÒÓÁ‰‡Ú¸ ÒÔËÒÓÍ ‰Îfl

‚ÓÒÔÓËÁ‚Â‰ÂÌËfl, ÍÓÚÓ˚È ËÏÂÂÚ ‡ÁÏÂ ÌÂ ·ÓÎÂÂ 3 É· Ë ‚ÍÎ˛˜‡ÂÚ ‚ ÒÂ·fl ÔÂÒÌË Ò ÂÈÚËÌ„ÓÏ

ÌÂ ÌËÊÂ 3 Á‚ÂÁ‰ (ÒÏ. ‡Á‰ÂÎ “êÂÈÚËÌ„ ÔÂÒÂÌ” Ì‡ ÒÚ‡ÌËˆÂ 19).

èÓÒÎÂ ÒÓÁ‰‡ÌËfl ÒÔËÒÍ‡ Smart Playlist ‚ÒÂ ËÏÔÓÚËÛÂÏ˚Â ÔÂÒÌË, ÒÓÓÚ‚ÂÚÒÚ‚Û˛˘ËÂ ÍËÚÂËflÏ

ÒÔËÒÍ‡ Smart Playlist, ‡‚ÚÓÏ‡ÚË˜ÂÒÍË ‰Ó·‡‚Îfl˛ÚÒfl ‚ ˝ÚÓÚ ÒÔËÒÓÍ.

ëÓÁ‰‡ÌËÂ ÒÔËÒÍÓ‚ ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl Ì‡ ‚‡¯ÂÏ ÍÓÏÔ¸˛ÚÂÂ
ÑÎfl ÒÓÁ‰‡ÌËfl ÒÔËÒÍ‡ ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl ‚ iTunes Ì‡ ÍÓÏÔ¸˛ÚÂÂ Macintosh:

■ ç‡ÊÏËÚÂ ÍÌÓÔÍÛ Ò ÔÎ˛ÒÓÏ (+) Ë ‚‚Â‰ËÚÂ ËÏfl, Á‡ÚÂÏ ÔÂÂÚ‡˘ËÚÂ ÔÂÒÌË ‚ ÌÓ‚˚È ÒÔËÒÓÍ.

ÑÎfl ÒÓÁ‰‡ÌËfl ÒÔËÒÍ‡ ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl ‚ MUSICMATCH Jukebox Ì‡ ÍÓÏÔ¸˛ÚÂÂ Windows PC:

1. éÚÍÓÈÚÂ ÓÍÌÓ Playlist (ÂÒÎË ÓÌÓ Â˘Â ÌÂ ÓÚÍ˚ÚÓ) Ë ˘ÂÎÍÌËÚÂ ‚ ÌÂÏ ÔÓ ÔÛÌÍÚÛ File.

2. ôÂÎÍÌËÚÂ ÔÓ ÔÛÌÍÚÛ Library Ë ÔÂÂÚ‡˘ËÚÂ ÔÂÒÌË ËÁ ·Ë·ÎËÓÚÂÍË ‚ ÓÍÌÓ Playlist.

3. ç‡ÊÏËÚÂ Save ‚ ÓÍÌÂ Playlist.

Ä‚ÚÓÏ‡ÚË˜ÂÒÍËÈ ÔÂÂÌÓÒ ÔÂÒÂÌ Ì‡ iPod
èÓ ÛÏÓÎ˜‡ÌË˛ iPod ‡‚ÚÓÏ‡ÚË˜ÂÒÍË Ó·ÌÓ‚ÎflÂÚÒfl, ÍÓ„‰‡ ‚˚ ÔÓ‰ÍÎ˛˜‡ÂÚÂ Â„Ó Í ÍÓÏÔ¸˛ÚÂÛ.

èÓ„‡ÏÏ‡ iTunes ËÎË MUSICMATCH Jukebox Ó·ÌÓ‚ÎflÂÚ ÏÛÁ˚Í‡Î¸ÌÛ˛ ·Ë·ÎËÓÚÂÍÛ iPod ‚

ÒÓÓÚ‚ÂÚÒÚ‚ËË Ò ÔÂÒÌflÏË Ë ÒÔËÒÍ‡ÏË ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl ‚ ÏÛÁ˚Í‡Î¸ÌÓÈ ·Ë·ÎËÓÚÂÍÂ ‚‡¯Â„Ó

ÍÓÏÔ¸˛ÚÂ‡, ÔÂÂÒ˚Î‡fl ÌÓ‚˚Â ÔÂÒÌË Ì‡ iPod Ë Û‰‡Îflfl ÔÂÒÌË, ÍÓÚÓ˚Â ÛÊÂ ÌÂ ÒÓ‰ÂÊ‡ÚÒfl ‚

ÏÛÁ˚Í‡Î¸ÌÓÈ ·Ë·ÎËÓÚÂÍÂ ÍÓÏÔ¸˛ÚÂ‡, Ò iPod.

ÖÒÎË ‚˚ ËÒÔÓÎ¸ÁÛÂÚÂ ÍÓÏÔ¸˛ÚÂ Macintosh, ‚˚ ÏÓÊÂÚÂ Ì‡ÒÚÓËÚ¸ iPod ‰Îfl ÔÂÂÒ˚ÎÍË ÚÓÎ¸ÍÓ

ÓÔÂ‰ÂÎÂÌÌ˚ı ÔÂÒÂÌ ËÁ ·Ë·ÎËÓÚÂÍË iTunes ‚ ÒÔËÒÍÂ Source.
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óÚÓ·˚ ÔÂÂÒÎ‡Ú¸ Ì‡ iPod ÚÓÎ¸ÍÓ ÓÔÂ‰ÂÎÂÌÌ˚Â ÔÂÒÌË:

1. Ç iTunes ÛÒÚ‡ÌÓ‚ËÚÂ ÙÎ‡ÊÍË fl‰ÓÏ Ò ÔÂÒÌflÏË, ÍÓÚÓ˚Â ‚˚ ıÓÚËÚÂ ÔÂÂÒÎ‡Ú¸ (ÔÓ ÛÏÓÎ˜‡ÌË˛

ÙÎ‡ÊÍË ÒÚÓflÚ fl‰ÓÏ ÒÓ ‚ÒÂÏË ÔÂÒÌflÏË).

2. Ç˚·ÂËÚÂ iPod ‚ ÒÔËÒÍÂ Source Ë Ì‡ÊÏËÚÂ ÍÌÓÔÍÛ Options.

3. Ç˚·ÂËÚÂ ÔÛÌÍÚ Only update checked songs.

Ä‚ÚÓÏ‡ÚË˜ÂÒÍËÈ ÔÂÂÌÓÒ ‚˚·‡ÌÌ˚ı ÒÔËÒÍÓ‚ ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl Ì‡ iPod
Ç˚ ÏÓÊÂÚÂ Ì‡ÒÚÓËÚ¸ iPod ‰Îfl Ó·ÌÓ‚ÎÂÌËfl ÚÓÎ¸ÍÓ ‚˚·‡ÌÌ˚ı ÒÔËÒÍÓ‚ ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl.

ùÚ‡ ÙÛÌÍˆËfl ÔÓÎÂÁÌ‡, ÂÒÎË ‚˚ ıÓÚËÚÂ ÔÂÂÌÂÒÚË Ì‡ iPod ÚÓÎ¸ÍÓ ˜‡ÒÚ¸ ‚‡¯ÂÈ ÏÛÁ˚Í‡Î¸ÌÓÈ

·Ë·ÎËÓÚÂÍË.

óÚÓ·˚ Ì‡ÒÚÓËÚ¸ iPod ‰Îfl Ó·ÌÓ‚ÎÂÌËfl ÚÓÎ¸ÍÓ ‚˚·‡ÌÌ˚ı ÒÔËÒÍÓ‚ ‰Îfl

‚ÓÒÔÓËÁ‚Â‰ÂÌËfl Ì‡ ÍÓÏÔ¸˛ÚÂÂ Macintosh:

1. Ç iTunes ‚˚·ÂËÚÂ iPod ‚ ÒÔËÒÍÂ Source Ë Ì‡ÊÏËÚÂ ÍÌÓÔÍÛ Options.

2. Ç˚·ÂËÚÂ ÔÛÌÍÚ Automatically update selected playlists only.

óÚÓ·˚ Ì‡ÒÚÓËÚ¸ iPod ‰Îfl Ó·ÌÓ‚ÎÂÌËfl ÚÓÎ¸ÍÓ ‚˚·‡ÌÌ˚ı ÒÔËÒÍÓ‚ ‰Îfl

‚ÓÒÔÓËÁ‚Â‰ÂÌËfl Ì‡ ÍÓÏÔ¸˛ÚÂÂ Windows PC:

1. Ç MUSICMATCH Jukebox ‚˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ File -> Send to a portable device.

2. Ç˚·ÂËÚÂ iPod ‚ ÒÔËÒÍÂ Source Ë Ì‡ÊÏËÚÂ ÍÌÓÔÍÛ Options.
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3. ôÂÎÍÌËÚÂ ÔÓ ‚ÍÎ‡‰ÍÂ Synchronization Ë ÛÒÚ‡ÌÓ‚ËÚÂ ÙÎ‡ÊÓÍ Selected playlist synchronization.

èÂÂÒ˚ÎÍ‡ ÔÂÒÂÌ Ë ÒÔËÒÍÓ‚ ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl Ì‡ iPod ‚Û˜ÌÛ˛
Ç˚ ÏÓÊÂÚÂ Ì‡ÒÚÓËÚ¸ iPod ‰Îfl ÔÂÂÒ˚ÎÍË ÔÂÒÂÌ ‚Û˜ÌÛ˛, ˜ÚÓ·˚ ÔÂÂÒ˚Î‡Ú¸ ÓÚ‰ÂÎ¸Ì˚Â ÔÂÒÌË Ë

ÒÔËÒÍË ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl.

äÓ„‰‡ iPod Ì‡ÒÚÓÂÌ Ì‡ Û˜ÌÛ˛ ÔÂÂÒ˚ÎÍÛ ÔÂÒÂÌ, ‡‚ÚÓÏ‡ÚË˜ÂÒÍÓÈ ÒËÌıÓÌËÁ‡ˆËË ÔË

ÔÓ‰ÍÎ˛˜ÂÌËË Í ÍÓÏÔ¸˛ÚÂÛ ÌÂ ÔÓËÒıÓ‰ËÚ.

ÑÎfl Ì‡ÒÚÓÈÍË iPod Ì‡ Û˜ÌÛ˛ ÔÂÂÒ˚ÎÍÛ ÔÂÒÂÌ ÔË ËÒÔÓÎ¸ÁÓ‚‡ÌËË ÍÓÏÔ¸˛ÚÂ‡ Macintosh:

1. Ç iTunes ‚˚·ÂËÚÂ ËÍÓÌÍÛ iPod ‚ ÒÔËÒÍÂ Source Ë Ì‡ÊÏËÚÂ ÍÌÓÔÍÛ Options.

2. Ç˚·ÂËÚÂ ÔÛÌÍÚ Manually manage songs and playlists.

ÑÎfl Û˜ÌÓÈ ÔÂÂÒ˚ÎÍË ÔÂÒÌË ËÎË ÒÔËÒÍ‡ ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl Ì‡ iPod ÔË

ËÒÔÓÎ¸ÁÓ‚‡ÌËË ÍÓÏÔ¸˛ÚÂ‡ Macintosh:
■ Ç iTunes ÔÂÂÚ‡˘ËÚÂ ÔÂÒÌ˛ ËÎË ÒÔËÒÓÍ ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl Ì‡ iPod.

ÑÎfl Ì‡ÒÚÓÈÍË iPod Ì‡ Û˜ÌÛ˛ ÔÂÂÒ˚ÎÍÛ ÔÂÒÂÌ ÔË ËÒÔÓÎ¸ÁÓ‚‡ÌËË ÍÓÏÔ¸˛ÚÂ‡

Windows PC:

1. Ç MUSICMATCH Jukebox ‚˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ File -> Send to a portable device.

2. Ç˚·ÂËÚÂ iPod ‚ ÒÔËÒÍÂ Source Ë Ì‡ÊÏËÚÂ ÍÌÓÔÍÛ Options.

3. ôÂÎÍÌËÚÂ ÔÓ ‚ÍÎ‡‰ÍÂ Synchronization Ë ÒÌËÏËÚÂ ÙÎ‡ÊÓÍ Selected playlist synchronization.
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ÑÎfl Û˜ÌÓÈ ÔÂÂÒ˚ÎÍË ÔÂÒÌË ËÎË ÒÔËÒÍ‡ ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl Ì‡ iPod ÔË

ËÒÔÓÎ¸ÁÓ‚‡ÌËË ÍÓÏÔ¸˛ÚÂ‡ Windows PC:

1. Ç MUSICMATCH Jukebox Ì‡ÊÏËÚÂ ÍÌÓÔÍÛ My Library, ˜ÚÓ·˚ ÓÚÍ˚Ú¸ ÓÍÌÓ Library.

2. Ç˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ File -> Send to a portable device.

3. èÂÂÚ‡˘ËÚÂ ÔÂÒÌË ËÎË ÒÔËÒÍË ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl ËÁ ÓÍÌ‡ Library Ì‡ iPod.

êÛ˜ÌÓÂ Û‰‡ÎÂÌËÂ ÔÂÒÂÌ Ë ÒÔËÒÍÓ‚ ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl Ò iPod
ÖÒÎË ‚˚ Ì‡ÒÚÓËÎË iPod Ì‡ Û˜ÌÛ˛ ÔÂÂÒ˚ÎÍÛ ÔÂÒÂÌ (ÒÏ. ÒÚ‡ÌËˆÛ 20), ‚˚ ÏÓÊÂÚÂ Û‰‡ÎflÚ¸

ÓÚ‰ÂÎ¸Ì˚Â ÔÂÒÌË Ë ÒÔËÒÍË ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl Ò iPod.

ÑÎfl Û‰‡ÎÂÌËfl ÔÂÒÌË ËÎË ÒÔËÒÍ‡ ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl Ò iPod ÔË ËÒÔÓÎ¸ÁÓ‚‡ÌËË

ÍÓÏÔ¸˛ÚÂ‡ Macintosh:

1. Ç˚·ÂËÚÂ iPod ‚ ÒÔËÒÍÂ iTunes Source.

2. Ç˚·ÂËÚÂ ÔÂÒÌ˛ ËÎË ÒÔËÒÓÍ ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl Ë Ì‡ÊÏËÚÂ ÍÌÓÔÍÛ Delete Ì‡ ÍÎ‡‚Ë‡ÚÛÂ.

ÑÎfl Û‰‡ÎÂÌËfl ÔÂÒÌË ËÎË ÒÔËÒÍ‡ ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl Ò iPod ÔË ËÒÔÓÎ¸ÁÓ‚‡ÌËË

ÍÓÏÔ¸˛ÚÂ‡ Windows PC:

1. Ç MUSICMATCH Jukebox ‚˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ File -> Send to a portable device.

2. Ç˚·ÂËÚÂ iPod ‚ ÒÔËÒÍÂ Source.

3. Ç˚·ÂËÚÂ ÔÂÒÌ˛ ËÎË ÒÔËÒÓÍ ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl Ë Ì‡ÊÏËÚÂ ÍÌÓÔÍÛ Remove.

êÛ˜Ì‡fl ÏÓ‰ËÙËÍ‡ˆËfl ÒÔËÒÍÓ‚ ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl Ì‡ iPod
ÖÒÎË ‚˚ Ì‡ÒÚÓËÎË iPod Ì‡ Û˜ÌÛ˛ ÔÂÂÒ˚ÎÍÛ ÔÂÒÂÌ (ÒÏ. ÒÚ‡ÌËˆÛ 26), ‚˚ ÏÓÊÂÚÂ ÒÓÁ‰‡‚‡Ú¸

ÌÓ‚˚Â ÒÔËÒÍË ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl Ì‡ iPod Ë ‰Ó·‡‚ÎflÚ¸ ‚ ÌËı ÔÂÒÌË ËÁ ÛÊÂ Á‡ÔËÒ‡ÌÌ˚ı Ì‡ iPod

ÒÔËÒÍÓ‚ ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl.
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ÑÎfl ÏÓ‰ËÙËÍ‡ˆËË ÒÔËÒÍ‡ ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl ËÎË ÒÓÁ‰‡ÌËfl ÌÓ‚Ó„Ó ÒÔËÒÍ‡ ‰Îfl

‚ÓÒÔÓËÁ‚Â‰ÂÌËfl Ì‡ iPod ÔË ËÒÔÓÎ¸ÁÓ‚‡ÌËË ÍÓÏÔ¸˛ÚÂ‡ Macintosh:

1. ÑÎfl ÒÓÁ‰‡ÌËfl ÌÓ‚Ó„Ó ÒÔËÒÍ‡ ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl ‚˚·ÂËÚÂ iPod ‚ ÒÔËÒÍÂ iTunes Source Ë

Ì‡ÊÏËÚÂ ÍÌÓÔÍÛ Ò ÔÎ˛ÒÓÏ (+).

2. èÂÂÚ‡˘ËÚÂ ÔÂÒÌË ‚ ÒÔËÒÓÍ ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl Ì‡ iPod.

ÑÎfl ÏÓ‰ËÙËÍ‡ˆËË ÒÔËÒÍ‡ ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl ËÎË ÒÓÁ‰‡ÌËfl ÌÓ‚Ó„Ó ÒÔËÒÍ‡ ‰Îfl

‚ÓÒÔÓËÁ‚Â‰ÂÌËfl Ì‡ iPod ÔË ËÒÔÓÎ¸ÁÓ‚‡ÌËË ÍÓÏÔ¸˛ÚÂ‡ Windows PC:

1. Ç MUSICMATCH Jukebox Ì‡ÊÏËÚÂ ÍÌÓÔÍÛ My Library, ˜ÚÓ·˚ ÓÚÍ˚Ú¸ ÓÍÌÓ Library.

2. Ç˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ File -> Send to a portable device.

3. èÂÂÚ‡˘ËÚÂ ÔÂÒÌË ËÎË ÒÔËÒÍË ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl ËÁ ÓÍÌ‡ Library ‚ ÒÔËÒÓÍ ‰Îfl

‚ÓÒÔÓËÁ‚Â‰ÂÌËfl Ì‡ iPod.

ÑÎfl ÒÓÁ‰‡ÌËfl ÌÓ‚Ó„Ó ÒÔËÒÍ‡ ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl Ì‡ iPod ÔË ËÒÔÓÎ¸ÁÓ‚‡ÌËË ÍÓÏÔ¸˛ÚÂ‡

Windows PC ‚˚ ÒÌ‡˜‡Î‡ ‰ÓÎÊÌ˚ ÒÓÁ‰‡Ú¸ ÒÔËÒÓÍ ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl Ì‡ ‚‡¯ÂÏ ÍÓÏÔ¸˛ÚÂÂ,

Á‡ÚÂÏ ÔÂÂÌÂÒÚË Â„Ó Ì‡ iPod (ÒÏ. ‡Á‰ÂÎ “ëÓÁ‰‡ÌËÂ ÒÔËÒÍÓ‚ ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl Ì‡ ‚‡¯ÂÏ

ÍÓÏÔ¸˛ÚÂÂ” Ì‡ ÒÚ‡ÌËˆÂ 24).

èÓÒÎÛ¯Ë‚‡ÌËÂ Â˜Ë Ò Audible.com
ÖÒÎË ‚˚ ËÒÔÓÎ¸ÁÛÂÚÂ ÍÓÏÔ¸˛ÚÂ Macintosh, ‚˚ ÏÓÊÂÚÂ ‚˚„ÛÊ‡Ú¸ Â˜Â‚˚Â Ù‡ÈÎ˚ Ò Audible.com,

ÓÚÍ˚‚‡Ú¸ Ëı Ò ÔÓÏÓ˘¸˛ iTunes Ë Á‡ÚÂÏ ÔÂÂÒ˚Î‡Ú¸ Ëı Ì‡ iPod.

ÑÎfl ÔÓÎÛ˜ÂÌËfl ËÌÙÓÏ‡ˆËË Ó ÚÓÏ, Í‡Í ‚˚„ÛÊ‡Ú¸ Ë ÔÓÒÎÛ¯Ë‚‡Ú¸ Â˜Â‚˚Â Ù‡ÈÎ˚ ‚ iTunes,

Á‡ÔÛÒÚËÚÂ ÔÓ„‡ÏÏÛ iTunes Ë ‚˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ Help -> iTunes Help. á‡ÚÂÏ Ì‡ÔÂ˜‡Ú‡ÈÚÂ

“audible” Ë Ì‡ÊÏËÚÂ ÍÎ‡‚Ë¯Û Return.

ÑÎfl ÔÓÎÛ˜ÂÌËfl ‰ÓÔÓÎÌËÚÂÎ¸ÌÓÈ ËÌÙÓÏ‡ˆËË Ó Â˜Â‚˚ı Ù‡ÈÎ‡ı, ÔÓÒÂÚËÚÂ Ò‡ÈÚ www.apple.com/ipod.
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ä‡Í ÛÁÌ‡Ú¸, ÒÍÓÎ¸ÍÓ ÔÂÒÂÌ Á‡ÔËÒ‡ÌÓ Ì‡ iPod
óÚÓ·˚ ÛÁÌ‡Ú¸, ÒÍÓÎ¸ÍÓ ÔÂÒÂÌ Á‡ÔËÒ‡ÌÓ Ì‡ iPod, ÒÍÓÎ¸ÍÓ Ò‚Ó·Ó‰ÌÓ„Ó ÏÂÒÚ‡ ÓÒÚ‡ÎÓÒ¸ Ì‡ ‰ËÒÍÂ Ë

‰Û„Û˛ ËÌÙÓÏ‡ˆË˛, ‚˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ Settings->About.

êÂ„ÛÎËÓ‚‡ÌËÂ Ì‡ÒÚÓÂÍ iPod
Ç˚ ÏÓÊÂÚÂ ÏÂÌflÚ¸ Ì‡ÒÚÓÈÍË iPod ‚ ÏÂÌ˛ Settings.

ç‡ÒÚÓÈÍ‡ iPod ‰Îfl ÔÂÂÏÂ¯‡ÌÌÓ„Ó ËÎË ÔÓ‚ÚÓfl˛˘Â„ÓÒfl
‚ÓÒÔÓËÁ‚Â‰ÂÌËfl ÔÂÒÂÌ
Ç˚ ÏÓÊÂÚÂ Ì‡ÒÚÓËÚ¸ iPod ‰Îfl ÔÓ‚ÚÓÂÌËfl ÔÂÒÌË ËÎË ÔÓÒÎÂ‰Ó‚‡ÚÂÎ¸ÌÓÒÚË ÔÂÒÂÌ.

Ç˚ Ú‡ÍÊÂ ÏÓÊÂÚÂ Ì‡ÒÚÓËÚ¸ Â„Ó ‰Îfl ÔÂÂÏÂ¯‡ÌÌÓ„Ó ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl (‚ÓÒÔÓËÁ‚Â‰ÂÌËÂ ÔÂÒÂÌ

ËÎË ‡Î¸·ÓÏÓ‚ ‚ ÒÎÛ˜‡ÈÌÓÏ ÔÓfl‰ÍÂ).

iPod ÔÓ‚ÚÓflÂÚ ËÎË ÔÂÂÏÂ¯Ë‚‡ÂÚ ÔÂÒÌË ‚ ÒÔËÒÍÂ (Ì‡ÔËÏÂ, ‡Î¸·ÓÏÂ ËÎË ÒÔËÒÍÂ ‰Îfl

‚ÓÒÔÓËÁ‚Â‰ÂÌËfl), ËÁ ÍÓÚÓÓ„Ó ·˚Î‡ ‚˚·‡Ì‡ ÔÂ‚‡fl ÔÂÒÌfl.

óÚÓ·˚ Ì‡ÒÚÓËÚ¸ iPod ‰Îfl ÔÓ‚ÚÓÌÓ„Ó ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl ÔÂÒÂÌ:
■ Ç˚·ÂËÚÂ ÔÛÌÍÚ Settings ‚ ÓÒÌÓ‚ÌÓÏ ÏÂÌ˛ iPod.

● óÚÓ·˚ ÔÓ‚ÚÓflÚ¸ ‚ÒÂ ÔÂÒÌË ‚ ÒÔËÒÍÂ, ÛÒÚ‡ÌÓ‚ËÚÂ ÁÌ‡˜ÂÌËÂ All ‚ ÔÛÌÍÚÂ Repeat.
● óÚÓ·˚ ÔÓ‚ÚÓflÚ¸ Ó‰ÌÛ ÔÂÒÌ˛, ÛÒÚ‡ÌÓ‚ËÚÂ ÁÌ‡˜ÂÌËÂ One ‚ ÔÛÌÍÚÂ Repeat.

óÚÓ·˚ Ì‡ÒÚÓËÚ¸ iPod ‰Îfl ÔÂÂÏÂ¯‡ÌÌÓ„Ó ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl ÔÂÒÂÌ:

1. Ç˚·ÂËÚÂ ÔÛÌÍÚ Settings ‚ ÓÒÌÓ‚ÌÓÏ ÏÂÌ˛ iPod.

2. ìÒÚ‡ÌÓ‚ËÚÂ ÁÌ‡˜ÂÌËÂ Shuffle ‚ ÔÛÌÍÚÂ Songs ËÎË Albums.

äÓ„‰‡ ‚˚ Ì‡ÒÚ‡Ë‚‡ÂÚÂ iPod ‰Îfl ÔÂÂÏÂ¯‡ÌÌÓ„Ó ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl ‡Î¸·ÓÏÓ‚, ÓÌ ÔÓË„˚‚‡ÂÚ

‚ÒÂ ÔÂÒÌË ‡Î¸·ÓÏ‡ ÔÓ ÔÓfl‰ÍÛ, Á‡ÚÂÏ ÒÎÛ˜‡ÈÌ˚Ï Ó·‡ÁÓÏ ‚˚·Ë‡ÂÚ ‰Û„ÓÈ ‡Î¸·ÓÏ Ë

ÔÓË„˚‚‡ÂÚ Â„Ó Ú‡ÍÊÂ ÔÓ ÔÓfl‰ÍÛ.
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äÓ„‰‡ iPod Ì‡ÒÚÓÂÌ ‰Îfl ÔÂÂÏÂ¯‡ÌÌÓ„Ó ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl, ÓÌ ÌÂ ·Û‰ÂÚ ÔÓ‚ÚÓflÚ¸ ÔÂÒÌ˛ ËÎË ‡Î¸·ÓÏ

‰Ó ÚÂı ÔÓ, ÔÓÍ‡ ÌÂ ÔÓË„‡ÂÚ ‚ÒÂ ÔÂÒÌË ‚ ÒÔËÒÍÂ, ËÁ ÍÓÚÓÓ„Ó ·˚Î‡ ‚˚·‡Ì‡ ÔÂ‚‡fl ÔÂÒÌfl.

ç‡ÒÚÓÈÍ‡ ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl ÔÂÒÂÌ ÔË Ó‰ËÌ‡ÍÓ‚ÓÈ ÓÚÌÓÒËÚÂÎ¸ÌÓÈ „ÓÏÍÓÒÚË
èÓ„‡ÏÏ˚ iTunes Ë MUSICMATCH Jukebox ÏÓ„ÛÚ ‡‚ÚÓÏ‡ÚË˜ÂÒÍË Â„ÛÎËÓ‚‡Ú¸ „ÓÏÍÓÒÚ¸

‚ÓÒÔÓËÁ‚Â‰ÂÌËfl ÔÂÒÂÌ, ˜ÚÓ·˚ ÓÌË ÔÓË„˚‚‡ÎËÒ¸ ÔË Ó‰ËÌ‡ÍÓ‚ÓÈ ÓÚÌÓÒËÚÂÎ¸ÌÓÈ „ÓÏÍÓÒÚË.

óÚÓ·˚ Ì‡ÒÚÓËÚ¸ iTunes ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl ÔÂÒÂÌ ÔË Ó‰ËÌ‡ÍÓ‚ÓÈ ÓÚÌÓÒËÚÂÎ¸ÌÓÈ

„ÓÏÍÓÒÚË:

1. Ç iTunes ‚˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ iTunes -> Preferences Ë Ì‡ÊÏËÚÂ ÍÌÓÔÍÛ Effects.

2. ìÒÚ‡ÌÓ‚ËÚÂ ÙÎ‡ÊÓÍ Sound Check.

ÑÎfl ÚÓ„Ó ˜ÚÓ·˚ iPod Ò˜ËÚ˚‚‡Î Ì‡ÒÚÓÈÍË „ÓÏÍÓÒÚË ËÁ iTunes:
■ Ç˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ Settings -> Sound Check.

äÓ„‰‡ ‚˚ ‚ÍÎ˛˜‡ÂÚÂ ‡‚ÚÓÏ‡ÚË˜ÂÒÍÛ˛ Â„ÛÎËÓ‚ÍÛ „ÓÏÍÓÒÚË ÔÂÒÂÌ ‚ MUSICMATCH Jukebox,

Ì‡ÒÚÓÈÍË ÔÂÂÒ˚Î‡˛ÚÒfl Ì‡ iPod ‡‚ÚÓÏ‡ÚË˜ÂÒÍË. ùÚÓ ÏÓÊÂÚ ÔË‚ÂÒÚË Í ÒÌËÊÂÌË˛ ÒÍÓÓÒÚË

ÔÂÂÒ˚ÎÍË. ÑÎfl ÔÓÎÛ˜ÂÌËfl ‰ÓÔÓÎÌËÚÂÎ¸ÌÓÈ ËÌÙÓÏ‡ˆËË Ó Â„ÛÎËÓ‚ÍÂ „ÓÏÍÓÒÚË ÔÂÒÂÌ ‚

MUSICMATCH Jukebox Ó·‡ÚËÚÂÒ¸ Í ÒÔ‡‚Ó˜ÌÓÏÛ Ù‡ÈÎÛ MUSICMATCH Jukebox Help.

àÒÔÓÎ¸ÁÓ‚‡ÌËÂ ˝Í‚‡Î‡ÈÁÂ‡ iPod
Ç˚ ÏÓÊÂÚÂ ËÒÔÓÎ¸ÁÓ‚‡Ú¸ ÔÂ‰ÛÒÚ‡ÌÓ‚ÎÂÌÌ˚Â Ì‡ÒÚÓÈÍË ˝Í‚‡Î‡ÈÁÂ‡, ˜ÚÓ·˚ Á‚ÛÍ iPod ÔÓ‰ıÓ‰ËÎ

‰Îfl ÍÓÌÍÂÚÌÓ„Ó Ê‡Ì‡ ËÎË ÒÚËÎfl ÏÛÁ˚ÍË. ç‡ÔËÏÂ, ˜ÚÓ·˚ ÛÎÛ˜¯ËÚ¸ Á‚Û˜‡ÌËÂ ÓÍ-ÏÛÁ˚ÍË,

‚˚·ÂËÚÂ Ì‡ÒÚÓÈÍË ˝Í‚‡Î‡ÈÁÂ‡ Rock.
■ Ç˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ Settings -> EQ Ë ‚˚·ÂËÚÂ Ì‡ÒÚÓÈÍË ˝Í‚‡Î‡ÈÁÂ‡.
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ç‡ÒÚÓÈÍ‡ Ú‡ÈÏÂ‡ ÔÓ‰Ò‚ÂÚÍË
Ç˚ ÏÓÊÂÚÂ Ì‡ÒÚÓËÚ¸ ÔÓ‰Ò‚ÂÚÍÛ, ˜ÚÓ·˚ ÓÌ‡ ‚ÍÎ˛˜‡Î‡Ò¸ Ì‡ ÓÔÂ‰ÂÎÂÌÌÓÂ ‚ÂÏfl, ÍÓ„‰‡ ‚˚

Ì‡ÊËÏ‡ÂÚÂ ÍÌÓÔÍÛ ËÎË ËÒÔÓÎ¸ÁÛÂÚÂ ÍÓÎÂÒËÍÓ ÔÓÍÛÚÍË.
■ Ç˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ Settings -> Backlight Timer Ë ‚˚·ÂËÚÂ ÔÂ‰ÔÓ˜ÚËÚÂÎ¸ÌÛ˛

ÔÓ‰ÓÎÊËÚÂÎ¸ÌÓÒÚ¸.

Ñ‡ÊÂ ÂÒÎË ‚˚ ÌÂ Ì‡ÒÚÓËÎË Ú‡ÈÏÂ ÔÓ‰Ò‚ÂÚÍË, ‚˚ ÏÓÊÂÚÂ ‚ÍÎ˛˜ËÚ¸ ÔÓ‰Ò‚ÂÚÍÛ ‚ Î˛·ÓÂ ‚ÂÏfl,

Ì‡Ê‡‚ Ë Û‰ÂÊ‡‚ ÍÌÓÔÍÛ Menu ËÎË ‚˚·‡‚ ÔÛÌÍÚ Backlight ËÁ ÓÒÌÓ‚ÌÓ„Ó ÏÂÌ˛.

óÂÂÁ ÌÂÒÍÓÎ¸ÍÓ ÒÂÍÛÌ‰ ÔÓ‰Ò‚ÂÚÍ‡ ÓÚÍÎ˛˜‡ÂÚÒfl.

ç‡ÒÚÓÈÍ‡ ÍÓÌÚ‡ÒÚÌÓÒÚË ˝Í‡Ì‡
1. Ç˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ Settings -> Contrast.

2. àÒÔÓÎ¸ÁÛÈÚÂ ÍÓÎÂÒËÍÓ ÔÓÍÛÚÍË ‰Îfl Ì‡ÒÚÓÈÍË ÍÓÌÚ‡ÒÚÌÓÒÚË.

ÖÒÎË ‚˚ ÒÎÛ˜‡ÈÌÓ Ò‰ÂÎ‡ÂÚÂ ÍÓÌÚ‡ÒÚÌÓÒÚ¸ ˝Í‡Ì‡ ÒÎË¯ÍÓÏ ÚÂÏÌÓÈ, ‚˚ ÏÓÊÂÚÂ ‚ÂÌÛÚ¸ ÁÌ‡˜ÂÌËfl

ÔÓ ÛÏÓÎ˜‡ÌË˛, Ì‡Ê‡‚ ÍÌÓÔÍÛ Menu Ë Û‰ÂÊ‡‚ ÂÂ ÔËÏÂÌÓ 4 ÒÂÍÛÌ‰˚.

ÑÓ·‡‚ÎÂÌËÂ ËÎË Û‰‡ÎÂÌËÂ ÔÛÌÍÚÓ‚ ËÁ ÓÒÌÓ‚ÌÓ„Ó ÏÂÌ˛
Ç˚ ÏÓÊÂÚÂ ‰Ó·‡‚ÎflÚ¸ ˜‡ÒÚÓ ËÒÔÓÎ¸ÁÛÂÏ˚Â ÔÛÌÍÚ˚ ‚ ÓÒÌÓ‚ÌÓÂ ÏÂÌ˛ iPod. ç‡ÔËÏÂ, ‚˚ ÏÓÊÂÚÂ

‰Ó·‡‚ËÚ¸ ÔÛÌÍÚ Songs ‚ ÓÒÌÓ‚ÌÓÂ ÏÂÌ˛, ˜ÚÓ·˚ ÌÂ ‚˚·Ë‡Ú¸ ÔÛÌÍÚ Browse ÔÂÂ‰ ÚÂÏ Í‡Í

‚˚·‡Ú¸ ÔÛÌÍÚ Songs.

óÚÓ·˚ ‰Ó·‡‚ËÚ¸ ËÎË Û‰‡ÎËÚ¸ ÔÛÌÍÚ˚ ËÁ ÓÒÌÓ‚ÌÓ„Ó ÏÂÌ˛:
■ Ç˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ Settings -> Main Menu.
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ç‡ÒÚÓÈÍ‡ Ë ÔÓÒÏÓÚ ‰‡Ú˚ Ë ‚ÂÏÂÌË
ÑÎfl Ì‡ÒÚÓÈÍË ‰‡Ú˚ Ë ‚ÂÏÂÌË:
■ Ç˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ Settings -> Date & Time.

ÑÎfl ÔÓÒÏÓÚ‡ ‰‡Ú˚ Ë ‚ÂÏÂÌË:
■ Ç˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ Extras -> Clock.

óÚÓ·˚ Ì‡ÒÚÓËÚ¸ iPod ‰Îfl ÓÚÓ·‡ÊÂÌËfl ‚ÂÏÂÌË ‚ Ô‡ÌÂÎË Á‡„ÓÎÓ‚Í‡:
■ Ç˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ Settings -> Date & Time.

ÖÒÎË ‚˚ Ì‡ÒÚÓËÎË iPod ‰Îfl ÓÚÓ·‡ÊÂÌËfl ‚ÂÏÂÌË ‚ Ô‡ÌÂÎË Á‡„ÓÎÓ‚Í‡, ‚˚ ÒÏÓÊÂÚÂ Û‚Ë‰ÂÚ¸

˜‡Ò˚ ‚ Î˛·ÓÏ ˝Í‡ÌÂ ÏÂÌ˛ iPod.

ç‡ÒÚÓÈÍ‡ ·Û‰ËÎ¸ÌËÍ‡
ÑÎfl Ì‡ÒÚÓÈÍË ·Û‰ËÎ¸ÌËÍ‡:

■ Ç˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ Extras -> Clock -> Alarm Clock.

ç‡ÒÚÓÈÍ‡ flÁ˚Í‡
iPod ÏÓÊÌÓ Ì‡ÒÚÓËÚ¸ ‰Îfl ËÒÔÓÎ¸ÁÓ‚‡ÌËfl ‡ÁÎË˜Ì˚ı flÁ˚ÍÓ‚.

■ Ç˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ Settings -> Languages Ë ‚˚·ÂËÚÂ flÁ˚Í.

ÖÒÎË ‚˚ ÒÎÛ˜‡ÈÌÓ ÛÒÚ‡ÌÓ‚ËÚÂ Ì‡ iPod flÁ˚Í, ÍÓÚÓ˚È ‚˚ ÌÂ ÔÓÌËÏ‡ÂÚÂ, ‚˚ ÏÓÊÂÚÂ Ò·ÓÒËÚ¸ ˝ÚÛ

Ì‡ÒÚÓÈÍÛ.

1. çÂÒÍÓÎ¸ÍÓ ‡Á Ì‡ÊÏËÚÂ ÍÌÓÔÍÛ Menu, ÔÓÍ‡ ÌÂ ÔÓfl‚ËÚÒfl ÓÒÌÓ‚ÌÓÂ ÏÂÌ˛.

2. Ç˚·ÂËÚÂ ˜ÂÚ‚ÂÚ˚È ÔÛÌÍÚ ÏÂÌ˛ (Settings).

3. Ç˚·ÂËÚÂ ÔÓÒÎÂ‰ÌËÈ ÔÛÌÍÚ ÏÂÌ˛ (Reset All Settings).

4. Ç˚·ÂËÚÂ ‚ÚÓÓÈ ÔÛÌÍÚ ÏÂÌ˛ (Reset) Ë ‚˚·ÂËÚÂ flÁ˚Í.



33ê‡·ÓÚ‡ Ò iPod

ÑÛ„ËÂ Ì‡ÒÚÓÈÍË iPod, Ú‡ÍËÂ, Í‡Í ÔÓ‚ÚÓÌÓÂ ‚ÓÒÔÓËÁ‚Â‰ÂÌËÂ ÔÂÒÂÌ, Ú‡ÍÊÂ Ò·‡Ò˚‚‡˛ÚÒfl.

á‡ÏÂ˜‡ÌËÂ. ÖÒÎË ‚˚ ‰Ó·‡‚ËÎË ËÎË Û‰‡ÎËÎË ÔÛÌÍÚ˚ ËÁ ÓÒÌÓ‚ÌÓ„Ó ÏÂÌ˛ (ÒÏ. ÒÚ‡ÌËˆÛ 32),

ÏÂÌ˛ Settings ÏÓÊÂÚ ÓÍ‡Á‡Ú¸Òfl ‚ ‰Û„ÓÏ ÏÂÒÚÂ.

ìÒÚ‡ÌÓ‚Í‡ Ú‡ÈÏÂ‡ ÓÚÍÎ˛˜ÂÌËfl
Ç˚ ÏÓÊÂÚÂ Ì‡ÒÚÓËÚ¸ iPod ‰Îfl ‡‚ÚÓÏ‡ÚË˜ÂÒÍÓ„Ó ÓÚÍÎ˛˜ÂÌËfl ˜ÂÂÁ ÛÍ‡Á‡ÌÌ˚È ÔÓÏÂÊÛÚÓÍ

‚ÂÏÂÌË.
■ Ç˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ Extras -> Clock -> Sleep Timer Ë ‚˚·ÂËÚÂ ÔÂ‰ÔÓ˜ÚËÚÂÎ¸Ì˚È ÔÓÏÂÊÛÚÓÍ

‚ÂÏÂÌË.

äÓ„‰‡ ‚˚ ÛÒÚ‡ÌÓ‚ËÚÂ Ú‡ÈÏÂ ÓÚÍÎ˛˜ÂÌËfl, ‚ ˝Í‡ÌÂ Now Playing ÔÓfl‚ËÚÒfl ËÍÓÌÍ‡ ˜‡ÒÓ‚ Ë

ÍÓÎË˜ÂÒÚ‚Ó ÏËÌÛÚ, ÓÒÚ‡‚¯ËıÒfl ‰Ó ÓÚÍÎ˛˜ÂÌËfl iPod.

àÒÔÓÎ¸ÁÓ‚‡ÌËÂ ‰ÓÔÓÎÌËÚÂÎ¸Ì˚ı ‚ÓÁÏÓÊÌÓÒÚÂÈ iPod

àÒÔÓÎ¸ÁÓ‚‡ÌËÂ iPod ‚ Í‡˜ÂÒÚ‚Â ‚ÌÂ¯ÌÂ„Ó ÊÂÒÚÍÓ„Ó ‰ËÒÍ‡
Ç˚ ÏÓÊÂÚÂ ËÒÔÓÎ¸ÁÓ‚‡Ú¸ iPod ‚ Í‡˜ÂÒÚ‚Â ‚ÌÂ¯ÌÂ„Ó ÊÂÒÚÍÓ„Ó ‰ËÒÍ‡ ‰Îfl ı‡ÌÂÌËfl Ë ÔÂÂÌÓÒ‡

Ù‡ÈÎÓ‚ Ò ‰‡ÌÌ˚ÏË.

ÑÎfl ËÒÔÓÎ¸ÁÓ‚‡ÌËfl iPod ‚ Í‡˜ÂÒÚ‚Â ‚ÌÂ¯ÌÂ„Ó ÊÂÒÚÍÓ„Ó ‰ËÒÍ‡ Ì‡ ÍÓÏÔ¸˛ÚÂÂ Macintosh:

1. Ç iTunes ‚˚·ÂËÚÂ iPod ‚ ÒÔËÒÍÂ Source Ë Ì‡ÊÏËÚÂ ÍÌÓÔÍÛ Options.

2. ìÒÚ‡ÌÓ‚ËÚÂ ÙÎ‡ÊÓÍ Enable FireWire disk use.
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ÑÎfl ËÒÔÓÎ¸ÁÓ‚‡ÌËfl iPod ‚ Í‡˜ÂÒÚ‚Â ‚ÌÂ¯ÌÂ„Ó ÊÂÒÚÍÓ„Ó ‰ËÒÍ‡ Ì‡ ÍÓÏÔ¸˛ÚÂÂ Windows PC:

1. Ç MUSICMATCH Jukebox ‚˚·ÂËÚÂ iPod ‚ ÒÔËÒÍÂ Source Ë Ì‡ÊÏËÚÂ ÍÌÓÔÍÛ Options.

2. ôÂÎÍÌËÚÂ ÔÓ ‚ÍÎ‡‰ÍÂ iPod Ë ÛÒÚ‡ÌÓ‚ËÚÂ ÙÎ‡ÊÓÍ Enable FireWire disk use.

äÓ„‰‡ ‚˚ ËÒÔÓÎ¸ÁÛÂÚÂ iPod ‚ Í‡˜ÂÒÚ‚Â ÊÂÒÚÍÓ„Ó ‰ËÒÍ‡, ËÍÓÌÍ‡ ‰ËÒÍ‡ iPod ÔÓfl‚ÎflÂÚÒfl Ì‡ ‡·Ó˜ÂÏ

ÒÚÓÎÂ ÍÓÏÔ¸˛ÚÂ‡ Macintosh ËÎË ÒÎÂ‰Û˛˘‡fl ‰ÓÒÚÛÔÌ‡fl ·ÛÍ‚‡ ‰ËÒÍ‡ ÔÓfl‚ÎflÂÚÒfl ‚ Windows Explorer

Ì‡ ÍÓÏÔ¸˛ÚÂÂ Windows PC.

á‡ÏÂ˜‡ÌËÂ. ìÒÚ‡ÌÓ‚Í‡ ÙÎ‡ÊÍ‡ Manually manage songs and playlists ‚ ÓÍÌÂ Options Ú‡ÍÊÂ ÔÓÁ‚ÓÎflÂÚ

ËÒÔÓÎ¸ÁÓ‚‡Ú¸ iPod ‚ Í‡˜ÂÒÚ‚Â ÊÂÒÚÍÓ„Ó ‰ËÒÍ‡.

á‡ÏÂ˜‡ÌËÂ. ÑÎfl ÔÂÂÒ˚ÎÍË ÏÛÁ˚Í‡Î¸Ì˚ı Ù‡ÈÎÓ‚ Ì‡ iPod ‚˚ ‰ÓÎÊÌ˚ ËÒÔÓÎ¸ÁÓ‚‡Ú¸ ÔÓ„‡ÏÏÛ

iTunes (Ì‡ ÍÓÏÔ¸˛ÚÂÂ Macintosh) ËÎË MUSICMATCH Jukebox (Ì‡ ÍÓÏÔ¸˛ÚÂÂ Windows PC). èÂÒÌË,

ÔÂÂÌÂÒÂÌÌ˚Â Ò ÔÓÏÓ˘¸˛ iTunes ËÎË MUSICMATCH Jukebox, ÌÂ ÔÓfl‚Îfl˛ÚÒfl Ì‡ iPod ‚ Macintosh

Finder ËÎË Windows Explorer. ÖÒÎË ‚˚ ÍÓÔËÛÂÚÂ ÏÛÁ˚Í‡Î¸Ì˚Â Ù‡ÈÎ˚ Ì‡ iPod ˜ÂÂÁ Macintosh

Finder ËÎË Windows Explorer, ‚˚ ÌÂ ÒÏÓÊÂÚÂ ‚ÓÒÔÓËÁ‚Ó‰ËÚ¸ Ëı Ì‡ iPod.

àÏÔÓÚ ‡‰ÂÒÓ‚, ÚÂÎÂÙÓÌÌ˚ı ÌÓÏÂÓ‚, Í‡ÎÂÌ‰‡Ì˚ı ÒÓ·˚ÚËÈ
Ë ÒÔËÒÍÓ‚ ‰ÂÎ
Ç‡¯ iPod ÏÓÊÂÚ ı‡ÌËÚ¸ ÍÓÌÚ‡ÍÚÌÛ˛ ËÌÙÓÏ‡ˆË˛, Í‡ÎÂÌ‰‡Ì˚Â ÒÓ·˚ÚËfl Ë ÒÔËÒÍË ‰ÂÎ, ÍÓÚÓ˚Â

ÏÓÊÌÓ ÔÓÒÏ‡ÚË‚‡Ú¸ ‚ ÔÛÚË. ÖÒÎË ‚˚ ËÒÔÓÎ¸ÁÛÂÚÂ ÍÓÏÔ¸˛ÚÂ Macintosh Ò Mac OS X Ë iSync, ÚÓ

Ò‰ÂÎ‡Ú¸ ˝ÚÓ ÏÓÊÌÓ, Ì‡Ê‡‚ ‚ÒÂ„Ó Ó‰ÌÛ ÍÌÓÔÍÛ.
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ÑÎfl ËÏÔÓÚ‡ ‚ÒÂÈ ËÌÙÓÏ‡ˆËË ÔË ËÒÔÓÎ¸ÁÓ‚‡ÌËË ÍÓÏÔ¸˛ÚÂ‡ Macintosh Ë

ÔÓ„‡ÏÏ˚ iSync:

1. á‡ÔÛÒÚËÚÂ iSync Ë ‚˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ Devices -> Add Device.

2. Ç˚·ÂËÚÂ iPod Ë Ì‡ÊÏËÚÂ ÍÌÓÔÍÛ Sync Now.

Ç ÒÎÂ‰Û˛˘ËÈ ‡Á, ÍÓ„‰‡ ‚˚ Á‡ıÓÚËÚÂ ÒËÌıÓÌËÁËÓ‚‡Ú¸ ËÌÙÓÏ‡ˆË˛ Ò iPod, ‚˚ ÏÓÊÂÚÂ ÔÓÒÚÓ

Á‡ÔÛÒÚËÚ¸ iSync Ë Ì‡Ê‡Ú¸ ÍÌÓÔÍÛ Sync Now. Ç˚ Ú‡ÍÊÂ ÏÓÊÂÚÂ Ì‡ÒÚÓËÚ¸ iPod ‰Îfl ‡‚ÚÓÏ‡ÚË˜ÂÒÍÓÈ

ÒËÌıÓÌËÁ‡ˆËË ÔË ÔÓ‰ÍÎ˛˜ÂÌËË. iSync ËÏÔÓÚËÛÂÚ ËÌÙÓÏ‡ˆË˛ ËÁ ÔÓ„‡ÏÏ iCal Ë Mac OS

X Address Book.

á‡ÏÂ˜‡ÌËÂ. iSync ÔÂÂÒ˚Î‡ÂÚ ËÌÙÓÏ‡ˆË˛ Ò ‚‡¯Â„Ó ÍÓÏÔ¸˛ÚÂ‡ Ì‡ iPod. Ç˚ ÌÂ ÏÓÊÂÚÂ

ËÒÔÓÎ¸ÁÓ‚‡Ú¸ iSync ‰Îfl ÔÂÂÒ˚ÎÍË ËÌÙÓÏ‡ˆËË Ò iPod Ì‡ ‚‡¯ ÍÓÏÔ¸˛ÚÂ.

ÑÎfl ÔÓÒÏÓÚ‡ ÍÓÌÚ‡ÍÚÌÓÈ ËÌÙÓÏ‡ˆËË Ì‡ iPod:
■ Ç˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ Extras -> Contacts.

ÑÎfl ÔÓÒÏÓÚ‡ Í‡ÎÂÌ‰‡Ì˚ı ÒÓ·˚ÚËÈ Ì‡ iPod:
■ Ç˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ Extras -> Calendar.

ÑÎfl ÔÓÒÏÓÚ‡ ÒÔËÒÍÓ‚ ‰ÂÎ:
■ Ç˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ Extras -> Calendar -> To-Do.

ÖÒÎË ‚˚ ËÒÔÓÎ¸ÁÛÂÚÂ Windows ËÎË ÌÂ ıÓÚËÚÂ ËÏÔÓÚËÓ‚‡Ú¸ ËÌÙÓÏ‡ˆË˛ Ò ÔÓÏÓ˘¸˛

ÔÓ„‡ÏÏ˚ iSync, ‚˚ ÏÓÊÂÚÂ ÔÂÂÒ˚Î‡Ú¸ ËÌÙÓÏ‡ˆË˛ Ì‡ iPod ‚Û˜ÌÛ˛. çÂÓ·ıÓ‰ËÏÓ

‡ÁÂ¯ËÚ¸ ËÒÔÓÎ¸ÁÓ‚‡Ú¸ iPod ‚ Í‡˜ÂÒÚ‚Â FireWire ÊÂÒÚÍÓ„Ó ‰ËÒÍ‡ (ÒÏ. ‡Á‰ÂÎ “àÒÔÓÎ¸ÁÓ‚‡ÌËÂ

iPod ‚ Í‡˜ÂÒÚ‚Â ‚ÌÂ¯ÌÂ„Ó ÊÂÒÚÍÓ„Ó ‰ËÒÍ‡” Ì‡ ÒÚ‡ÌËˆÂ 33).
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ÑÎfl ËÏÔÓÚ‡ ÍÓÌÚ‡ÍÚÌÓÈ ËÌÙÓÏ‡ˆËË ‚Û˜ÌÛ˛:

1. èÓ‰ÍÎ˛˜ËÚÂ iPod Ë Á‡ÔÛÒÚËÚÂ ‚‡¯Û ÔÓ˜ÚÓ‚Û˛ ÔÓ„‡ÏÏÛ ËÎË Ó„‡Ì‡ÈÁÂ. àÏÔÓÚËÓ‚‡ÌËÂ

ËÌÙÓÏ‡ˆËË ÏÓÊÌÓ ÓÒÛ˘ÂÒÚ‚ÎflÚ¸, Ì‡ÔËÏÂ, ËÁ ÔÓ„‡ÏÏ Palm Desktop, Microsoft Outlook,

Microsoft Entourage Ë Eudora.

2. ùÍÒÔÓÚËÛÈÚÂ ÍÓÌÚ‡ÍÚÌÛ˛ ËÌÙÓÏ‡ˆË˛ ‚ Ù‡ÈÎ˚ vCard Ë ÒÍÓÔËÛÈÚÂ Ëı ‚ Ô‡ÔÍÛ Contacts

Ì‡ iPod. óÚÓ·˚ Ò‰ÂÎ‡Ú¸ ˝ÚÓ, ÔÂÂÚ‡˘ËÚÂ ÍÓÌÚ‡ÍÚÌ˚Â Á‡ÔËÒË ËÁ ‡‰ÂÒÌÓÈ ÍÌË„Ë ÔËÎÓÊÂÌËfl

‚ Ô‡ÔÍÛ Contacts Ì‡ iPod.

ÑÎfl ËÏÔÓÚ‡ ËÌÙÓÏ‡ˆËË Ó ‚ÒÚÂ˜‡ı Ë ‰Û„Ëı Í‡ÎÂÌ‰‡Ì˚ı ÒÓ·˚ÚËflı ‚Û˜ÌÛ˛:

1. ùÍÒÔÓÚËÛÈÚÂ Í‡ÎÂÌ‰‡Ì˚Â ÒÓ·˚ÚËfl ËÁ Î˛·Ó„Ó ÔËÎÓÊÂÌËfl-Í‡ÎÂÌ‰‡fl, ËÒÔÓÎ¸ÁÛ˛˘Â„Ó

ÒÚ‡Ì‰‡ÚÌ˚È ÙÓÏ‡Ú iCalendar (ËÏÂÌ‡ Ù‡ÈÎÓ‚ ÓÍ‡Ì˜Ë‚‡˛ÚÒfl Ì‡ .icn) ËÎË ÙÓÏ‡Ú vCal (ËÏÂÌ‡

Ù‡ÈÎÓ‚ ÓÍ‡Ì˜Ë‚‡˛ÚÒfl Ì‡ .vcs).

2. èÓÏÂÒÚËÚÂ Ù‡ÈÎ˚ ‚ Ô‡ÔÍÛ Calendars Ì‡ iPod.

á‡ÏÂ˜‡ÌËÂ. ëÔËÒÍË ‰ÂÎ Ì‡ iPod ‚˚ ÏÓÊÂÚÂ ÔÓÒÏ‡ÚË‚‡Ú¸ ÚÓÎ¸ÍÓ Ò ÔÓÏÓ˘¸˛ ÔÓ„‡ÏÏ iSync Ë iCal.

á‡ÔËÒ¸ Ë ˜ÚÂÌËÂ Á‡ÏÂÚÓÍ Ë ‰Û„ÓÈ ËÌÙÓÏ‡ˆËË
Ç˚ ÏÓÊÂÚÂ ËÒÔÓÎ¸ÁÓ‚‡Ú¸ iPod ‰Îfl ˜ÚÂÌËfl Á‡ÏÂÚÓÍ.

1. ëÓı‡ÌËÚÂ ‰ÓÍÛÏÂÌÚ ‚ Î˛·ÓÏ ÚÂÍÒÚÓ‚ÓÏ ÔÓˆÂÒÒÓÂ ‚ ‚Ë‰Â ÚÂÍÒÚÓ‚Ó„Ó Ù‡ÈÎ‡ (.txt).

2. èÓÏÂÒÚËÚÂ Ù‡ÈÎ ‚ Ô‡ÔÍÛ Reader Ì‡ iPod.

ÑÎfl ÔÓÒÏÓÚ‡ Á‡ÏÂÚÓÍ:
■ Ç˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ Extras -> Reader.

à„˚
iPod ÒÓ‰ÂÊËÚ ÏÌÓÊÂÒÚ‚Ó Ë„.

■ óÚÓ·˚ Ò˚„‡Ú¸ ‚ Ë„Û, ‚˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ Extras -> Games Ë ‚˚·ÂËÚÂ Ë„Û.
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ÄÍÒÂÒÒÛ‡˚ iPod
åÌÓÊÂÒÚ‚Ó ‡ÍÒÂÒÒÛ‡Ó‚ ‰Îfl iPod ÏÓÊÌÓ ÔËÓ·ÂÒÚË Ì‡ Ò‡ÈÚÂ www.apple.ru/whereby Û ·ËÁÌÂÒ-

Ô‡ÚÌÂÓ‚ Ë ‡‚ÚÓËÁËÓ‚‡ÌÌ˚ı ‰ËÎÂÓ‚ Apple.

èÛÎ¸Ú ‰ËÒÚ‡ÌˆËÓÌÌÓ„Ó ÛÔ‡‚ÎÂÌËfl iPod Remote (ÔÓÒÚ‡‚ÎflÂÚÒfl
Ò ÌÂÍÓÚÓ˚ÏË ÏÓ‰ÂÎflÏË)
ÑÎfl ÚÓ„Ó ˜ÚÓ·˚ ËÒÔÓÎ¸ÁÓ‚‡Ú¸ ÔÛÎ¸Ú ‰ËÒÚ‡ÌˆËÓÌÌÓ„Ó ÛÔ‡‚ÎÂÌËfl iPod Remote, ÔÓ‰ÍÎ˛˜ËÚÂ Â„Ó Í ÔÓÚÛ

iPod Remote, Á‡ÚÂÏ ÔÓ‰ÍÎ˛˜ËÚÂ Ì‡Û¯ÌËÍË Apple Earphones (ËÎË ‰Û„ËÂ Ì‡Û¯ÌËÍË) Í ÔÛÎ¸ÚÛ

‰ËÒÚ‡ÌˆËÓÌÌÓ„Ó ÛÔ‡‚ÎÂÌËfl. àÒÔÓÎ¸ÁÛÈÚÂ ÍÌÓÔÍË Ì‡ ÔÛÎ¸ÚÂ iPod Remote Ú‡Í ÊÂ, Í‡Í Ë ÍÌÓÔÍË iPod.

Ç˚ ÏÓÊÂÚÂ ËÒÔÓÎ¸ÁÓ‚‡Ú¸ ÔÂÂÍÎ˛˜‡ÚÂÎ¸ Hold Ì‡ ÔÛÎ¸ÚÂ iPod Remote ‰Îfl ÓÚÍÎ˛˜ÂÌËfl ÍÌÓÔÓÍ ÔÛÎ¸Ú‡.

èÂÂÍÎ˛˜‡ÚÂÎ¸ Hold Ì‡ iPod Ë ÔÂÂÍÎ˛˜‡ÚÂÎ¸ Hold Ì‡ ÔÛÎ¸ÚÂ iPod Remote ÌÂ ‚ÎËfl˛Ú ‰Û„ Ì‡ ‰Û„‡.
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ÑÓÍ iPod Dock (ÔÓÒÚ‡‚ÎflÂÚÒfl Ò ÌÂÍÓÚÓ˚ÏË ÏÓ‰ÂÎflÏË)
iPod ÔÓÏÂ˘‡ÂÚÒfl ‚ ‰ÓÍ ÒÚÓÈÏfl ‰Îfl ÔÓ‰Á‡fl‰ÍË ËÎË ÔÂÂÒ˚ÎÍË ÏÛÁ˚ÍË. èÓ‰ÍÎ˛˜ËÚÂ Ó‰ËÌ ÍÓÌÂˆ

Í‡·ÂÎfl iPod Í ‚‡¯ÂÏÛ ÍÓÏÔ¸˛ÚÂÛ ËÎË Í ˝ÎÂÍÚË˜ÂÒÍÓÈ ÓÁÂÚÍÂ, ‡ ‰Û„ÓÈ ÍÓÌÂˆ Í ‰ÓÍÛ. á‡ÚÂÏ

ÔÓÏÂÒÚËÚÂ iPod ‚ ‰ÓÍ.

àÒÔÓÎ¸ÁÛfl ‰ÓÍ iPod Dock, ‚˚ ÏÓÊÂÚÂ ‚ÓÒÔÓËÁ‚Ó‰ËÚ¸ ÏÛÁ˚ÍÛ Ò iPod ˜ÂÂÁ ‡ÍÚË‚Ì˚Â ‚ÌÂ¯ÌËÂ

ÍÓÎÓÌÍË ËÎË ‰ÓÏ‡¯Ì˛˛ ÒÚÂÂÓÒËÒÚÂÏÛ. Ç‡Ï ÔÓÌ‡‰Ó·ËÚÒfl ‡Û‰ËÓÍ‡·ÂÎ¸ ÒÓ ÒÚ‡Ì‰‡ÚÌ˚Ï 3,5 ÏÏ

ÏËÌË-‡Á˙ÂÏÓÏ (ÏÌÓ„ËÂ ‚ÌÂ¯ÌËÂ ÍÓÎÓÌÍË ÒÌ‡·ÊÂÌ˚ Ú‡ÍËÏ Í‡·ÂÎÂÏ).

èÓÚ FireWire 400
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ÑÎfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl ÏÛÁ˚ÍË Ò iPod ÔË ËÒÔÓÎ¸ÁÓ‚‡ÌËË ‰ÓÍ‡ iPod Dock:

1. èÓÏÂÒÚËÚÂ iPod ‚ ‰ÓÍ.

2. èÓ‰ÍÎ˛˜ËÚÂ ÍÓÎÓÌÍË ËÎË ‰ÓÏ‡¯Ì˛˛ ÒÚÂÂÓÒËÒÚÂÏÛ Í ÔÓÚÛ Dock Line Out.

3. àÒÔÓÎ¸ÁÛÈÚÂ Ó„‡Ì˚ ÛÔ‡‚ÎÂÌËfl iPod ‰Îfl ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl ÔÂÒÌË.

äÓ„‰‡ ‰ÓÍ ÔÓ‰ÍÎ˛˜ÂÌ Í ‚ÌÂ¯ÌÂÏÛ ‡Û‰ËÓËÒÚÓ˜ÌËÍÛ, ËÒÔÓÎ¸ÁÛÈÚÂ Â„ÛÎflÚÓ˚ „ÓÏÍÓÒÚË

Ì‡ ‚ÌÂ¯ÌÂÏ ËÒÚÓ˜ÌËÍÂ ‰Îfl ËÁÏÂÌÂÌËfl „ÓÏÍÓÒÚË Á‚ÛÍ‡.

èÓÚ Line Out

ä‡·ÂÎ¸ iPod Dock Connector - FireWire

ê‡Á˙ÂÏ ‰Îfl iPod
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ç‡Û¯ÌËÍË Apple Earphones
iPod ÔÓÒÚ‡‚ÎflÂÚÒfl Ò Ô‡ÓÈ ‚˚ÒÓÍÓÍ‡˜ÂÒÚ‚ÂÌÌ˚ı Û‰Ó·Ì˚ı Ì‡Û¯ÌËÍÓ‚.

ÑÎfl ËÒÔÓÎ¸ÁÓ‚‡ÌËfl Ì‡Û¯ÌËÍÓ‚:
■ èÓ‰ÍÎ˛˜ËÚÂ Ëı Í ‡Á˙ÂÏÛ ‰Îfl Ì‡Û¯ÌËÍÓ‚, Á‡ÚÂÏ ‚ÒÚ‡‚¸ÚÂ Ëı ‚ Û¯Ë, Í‡Í ÔÓÍ‡Á‡ÌÓ Ì‡ ËÒÛÌÍÂ.

ÑÓÒÚÛÔÌ˚Â ‡ÍÒÂÒÒÛ‡˚
ÑÎfl ÔËÓ·ÂÚÂÌËfl ‡ÍÒÂÒÒÛ‡Ó‚ iPod Ó·‡˘‡ÈÚÂÒ¸ Í ·ËÁÌÂÒ-Ô‡ÚÌÂ‡Ï Ë ‡‚ÚÓËÁËÓ‚‡ÌÌ˚Ï

‰ËÎÂ‡Ï.

ÑÓÒÚÛÔÌ˚Â ‡ÍÑÓÒÚÛÔÌ˚Â ‡ÍÒÂÒÒÛÒÂÒÒÛ‡˚:‡˚:
● ‰ÓÍ iPod Dock
● ÔÛÎ¸Ú ‰ËÒÚ‡ÌˆËÓÌÌÓ„Ó ÛÔ‡‚ÎÂÌËfl iPod Remote + Ì‡Û¯ÌËÍË

ÇÌËÏ‡ÌËÂ! èÓÒÎÛ¯Ë‚‡ÌËÂ ÏÛÁ˚ÍË ÔË ·ÓÎ¸¯ÓÈ „ÓÏÍÓÒÚË ‚ ÚÂ˜ÂÌËÂ ‰ÎËÚÂÎ¸ÌÓ„Ó

‚ÂÏÂÌË ÏÓÊÂÚ ÔÓ‚Â‰ËÚ¸ ‚‡¯ ÒÎÛı.
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● Í‡·ÂÎ¸ iPod Dock Connector - FireWire
● Í‡·ÂÎ¸ iPod Dock Connector - USB 2.0 + FireWire
● ‡‰‡ÔÚÂ ÔËÚ‡ÌËfl iPod Power Adapter
● ˜ÂıÓÎ ‰Îfl iPod
● Ì‡·Ó ‚ËÎÓÍ World Travel Adapter Kit
● ÍÓÎÓÌÍË, Ì‡Û¯ÌËÍË, ‡‰‡ÔÚÂ˚ ‰Îfl ‡‚ÚÓÏÓ·ËÎ¸Ì˚ı ÒÚÂÂÓÒËÒÚÂÏ, ‡‰‡ÔÚÂ˚ ÔËÚ‡ÌËfl Ë ‰Û„ËÂ

‡ÍÒÂÒÒÛ‡˚

á‡fl‰Í‡ ·‡Ú‡ÂË iPod
iPod ÒÌ‡·ÊÂÌ ‚ÌÛÚÂÌÌÂÈ ÌÂÁ‡ÏÂÌflÂÏÓÈ ·‡Ú‡ÂÂÈ. èÓÎÌÓÒÚ¸˛ Á‡flÊÂÌÌ‡fl ·‡Ú‡Âfl

Ó·ÂÒÔÂ˜Ë‚‡ÂÚ ÔËÏÂÌÓ 8 ˜‡ÒÓ‚ ‡ÍÚË‚ÌÓÈ ‡·ÓÚ˚. ÖÒÎË iPod ÌÂ ËÒÔÓÎ¸ÁÛÂÚÒfl Í‡ÍÓÂ-ÚÓ ‚ÂÏfl,

·‡Ú‡Â˛, ‚ÓÁÏÓÊÌÓ, ÌÛÊÌÓ ·Û‰ÂÚ ÔÂÂÁ‡fl‰ËÚ¸.

Å‡Ú‡Âfl iPod Á‡flÊ‡ÂÚÒfl Ì‡ 80 ÔÓˆÂÌÚÓ‚ ÔËÏÂÌÓ Á‡ ˜‡Ò Ë ÔÓÎÌÓÒÚ¸˛ Á‡flÊ‡ÂÚÒfl Á‡ 4 ˜‡Ò‡.

ÖÒÎË ‚˚ Á‡flÊ‡ÂÚÂ iPod ‚Ó ‚ÂÏfl ÔÂÂÒ˚ÎÍË Ù‡ÈÎÓ‚ ËÎË ‚ÓÒÔÓËÁ‚Â‰ÂÌËfl ÏÛÁ˚ÍË, ÚÓ Ì‡

Á‡fl‰ÍÛ ÏÓÊÂÚ ÛÈÚË ·ÓÎ¸¯Â ‚ÂÏÂÌË.

ÇÒÂ ÍÓÏÔ¸˛ÚÂ˚ Macintosh Ë ÌÂÍÓÚÓ˚Â ÍÓÏÔ¸˛ÚÂ˚ Windows PC Ò 6-ÍÓÌÚ‡ÍÚÌ˚ÏË ÔÓÚ‡ÏË

FireWire ÏÓ„ÛÚ Á‡flÊ‡Ú¸ iPod ˜ÂÂÁ Í‡·ÂÎ¸ FireWire.

ÑÎfl Á‡fl‰ÍË ·‡Ú‡ÂË iPod Ò ÔÓÏÓ˘¸˛ ÍÓÏÔ¸˛ÚÂ‡ Macintosh ËÎË Windows PC:
■ èÓ‰ÍÎ˛˜ËÚÂ iPod Í ‚‡¯ÂÏÛ ÍÓÏÔ¸˛ÚÂÛ Ò ÔÓÏÓ˘¸˛ Í‡·ÂÎfl FireWire. äÓÏÔ¸˛ÚÂ ‰ÓÎÊÂÌ ·˚Ú¸

‚ÍÎ˛˜ÂÌ Ë ÌÂ Ì‡ıÓ‰ËÚ¸Òfl ‚ ÂÊËÏÂ ÓÊË‰‡ÌËfl.

ÖÒÎË ‚ ËÍÓÌÍÂ ·‡Ú‡ÂË ‚ Ô‡‚ÓÏ ‚ÂıÌÂÏ Û„ÎÛ ÔÓÍ‡Á˚‚‡ÂÚÒfl ÏÓÎÌËfl, ÁÌ‡˜ËÚ, ·‡Ú‡Âfl ÔÓÎÛ˜‡ÂÚ

˝ÌÂ„Ë˛.
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ÑÎfl Á‡fl‰ÍË ·‡Ú‡ÂË iPod Ò ÔÓÏÓ˘¸˛ ‡‰‡ÔÚÂ‡ iPod Power Adapter:

1. èÓ‰ÍÎ˛˜ËÚÂ ¯ÌÛ ‡‰‡ÔÚÂ‡ Í ‡‰‡ÔÚÂÛ ÔËÚ‡ÌËfl.

2. èÓ‰ÍÎ˛˜ËÚÂ Ó‰ËÌ ÍÓÌÂˆ Í‡·ÂÎfl FireWire, ÔÓÒÚ‡‚ÎflÂÏÓ„Ó Ò iPod, Í ‡‰‡ÔÚÂÛ ÔËÚ‡ÌËfl, ‡ ‰Û„ÓÈ

ÍÓÌÂˆ Í iPod.

3. èÓ‰ÍÎ˛˜ËÚÂ ‡‰‡ÔÚÂ ÔËÚ‡ÌËfl Í ËÒÔ‡‚ÌÓÈ ˝ÎÂÍÚË˜ÂÒÍÓÈ ÓÁÂÚÍÂ.

á‡ÏÂ˜‡ÌËÂ. Ç˚ ÌÂ ÏÓÊÂÚÂ Á‡fl‰ËÚ¸ iPod ÔË ÔÓÏÓ˘Ë Í‡·ÂÎfl USB.

ÇÌËÏ‡ÌËÂ! ì·Â‰ËÚÂÒ¸, ˜ÚÓ ‡‰‡ÔÚÂ ÔËÚ‡ÌËfl ÔÓÎÌÓÒÚ¸˛ ÒÓ·‡Ì,

ÔÂÂ‰ ÚÂÏ Í‡Í ÔÓ‰ÍÎ˛˜‡Ú¸ Â„Ó Í ˝ÎÂÍÚË˜ÂÒÍÓÈ ÓÁÂÚÍÂ.

ä‡·ÂÎ¸ iPod Dock
Connector - FireWire
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ëÓÒÚÓflÌËfl ·‡Ú‡ÂË
äÓ„‰‡ iPod ÌÂ ÔÓ‰ÍÎ˛˜ÂÌ Í ËÒÚÓ˜ÌËÍÛ ÔËÚ‡ÌËfl, ËÍÓÌÍ‡ ·‡Ú‡ÂË ‚ Ô‡‚ÓÏ ‚ÂıÌÂÏ Û„ÎÛ ˝Í‡Ì‡

iPod ÔÓÍ‡Á˚‚‡ÂÚ, Ì‡ÒÍÓÎ¸ÍÓ Á‡flÊÂÌ‡ ·‡Ú‡Âfl.

ÖÒÎË iPod ÔÓ‰ÍÎ˛˜ÂÌ Í ËÒÚÓ˜ÌËÍÛ ÔËÚ‡ÌËfl, ËÍÓÌÍ‡ ·‡Ú‡ÂË ÔÓÍ‡Á˚‚‡ÂÚ ‡ÌËÏ‡ˆË˛ ÔÓ‰Á‡fl‰ÍË.

ÖÒÎË ‚˚ ÔÓ‰ÍÎ˛˜ËÎË iPod Í ËÒÚÓ˜ÌËÍÛ ÔËÚ‡ÌËfl Ë ËÍÓÌÍ‡ ·‡Ú‡ÂË ÌÂ ÔÓÍ‡Á˚‚‡ÂÚ ‡ÌËÏ‡ˆËË,

ÁÌ‡˜ËÚ, ·‡Ú‡Âfl ÔÓÎÌÓÒÚ¸˛ Á‡flÊÂÌ‡.

Ç˚ ÏÓÊÂÚÂ ÓÚÍÎ˛˜ËÚ¸ iPod Ë ËÒÔÓÎ¸ÁÓ‚‡Ú¸ Â„Ó Â˘Â ‰Ó ÚÓ„Ó, Í‡Í ÓÌ ÔÓÎÌÓÒÚ¸˛ Á‡fl‰ËÚÒfl.

Å‡Ú‡Âfl Á‡flÊÂÌ‡
ÔËÏÂÌÓ Ì‡ÔÓÎÓ‚ËÌÛ

Å‡Ú‡Âfl Á‡flÊ‡ÂÚÒfl

Å‡Ú‡Âfl ÔÓÎÌÓÒÚ¸˛ Á‡flÊÂÌ‡
(ÂÒÎË ÌÂÚ ‡ÌËÏ‡ˆËË)
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èÂÂÁ‡ÔÛÒÍ iPod
ÅÓÎ¸¯ËÌÒÚ‚Ó ÔÓ·ÎÂÏ Ò iPod ÏÓÊÌÓ Â¯ËÚ¸ Ò ÔÓÏÓ˘¸˛ ÔÂÂÁ‡ÔÛÒÍ‡ iPod.

ÑÎfl ÔÂÂÁ‡ÔÛÒÍ‡ iPod:

1. èÓ‰ÍÎ˛˜ËÚÂ iPod Í ˝ÎÂÍÚË˜ÂÒÍÓÈ ÓÁÂÚÍÂ Ò ÔÓÏÓ˘¸˛ ‡‰‡ÔÚÂ‡ iPod Power Adapter.

2. èÂÂ‰‚ËÌ¸ÚÂ ÔÂÂÍÎ˛˜‡ÚÂÎ¸ Hold ÚÛ‰‡ Ë Ó·‡ÚÌÓ (ÔÂÂÍÎ˛˜ËÚÂ Â„Ó ‚ ÔÓÎÓÊÂÌËÂ Hold, Á‡ÚÂÏ

‚ÂÌËÚÂ ‚ ÔÓÎÓÊÂÌËÂ “‚˚ÍÎ˛˜ÂÌÓ”).

3. ç‡ÊÏËÚÂ ÍÌÓÔÍË Play/Pause Ë Menu Ë Û‰ÂÊËÚÂ Ëı Ì‡Ê‡Ú˚ÏË ‚ ÚÂ˜ÂÌËÂ 5 ÒÂÍÛÌ‰ ‰Ó ÚÂı ÔÓ,

ÔÓÍ‡ ÌÂ ÔÓfl‚ËÚÒfl ÎÓ„ÓÚËÔ Apple.

åÓÈ iPod ÌÂ ‚ÍÎ˛˜‡ÂÚÒfl ËÎË ÌÂ Â‡„ËÛÂÚ Ì‡ Ì‡Ê‡ÚËÂ ÍÌÓÔÓÍ
● ì·Â‰ËÚÂÒ¸, ˜ÚÓ ÔÂÂÍÎ˛˜‡ÚÂÎ¸ Hold Ì‡ ÍÓÔÛÒÂ iPod Ì‡ıÓ‰ËÚÒfl ‚ ÔÓÎÓÊÂÌËË “‚˚ÍÎ˛˜ÂÌÓ”.
● ÖÒÎË ‚˚ ËÒÔÓÎ¸ÁÛÂÚÂ ÔÛÎ¸Ú Apple iPod Remote, Û·Â‰ËÚÂÒ¸, ˜ÚÓ ÔÂÂÍÎ˛˜‡ÚÂÎ¸ Hold Ì‡ ÍÓÔÛÒÂ

ÔÛÎ¸Ú‡ Ì‡ıÓ‰ËÚÒfl ‚ ÔÓÎÓÊÂÌËË “‚˚ÍÎ˛˜ÂÌÓ”.
● ÖÒÎË ˝ÚÓ ÌÂ ÔÓÏÓÊÂÚ, ÔÓ‰ÍÎ˛˜ËÚÂ iPod Í ‡‰‡ÔÚÂÛ iPod Power Adapter Ë ‚ÍÎ˛˜ËÚÂ Â„Ó ‚

ËÒÔ‡‚ÌÛ˛ ˝ÎÂÍÚË˜ÂÒÍÛ˛ ÓÁÂÚÍÛ. ÇÓÁÏÓÊÌÓ, ·‡Ú‡Â˛ ‚‡¯Â„Ó iPod ÌÂÓ·ıÓ‰ËÏÓ ÔÓ‰Á‡fl‰ËÚ¸.
● ÖÒÎË Ë ˝ÚÓ ÌÂ ÔÓÏÓÊÂÚ, ‚‡Ï ÒÎÂ‰ÛÂÚ ÔÂÂÁ‡ÔÛÒÚËÚ¸ iPod (ÒÏ. ‚˚¯Â).
● ÖÒÎË ÌÂ ÔÓÏÓÊÂÚ Ë ˝ÚÓ, ‚‡Ï ÔÓÚÂ·ÛÂÚÒfl ‚ÓÒÒÚ‡ÌÓ‚ËÚ¸ ÔÓ„‡ÏÏÌÓÂ Ó·ÂÒÔÂ˜ÂÌËÂ iPod.

èÓ„‡ÏÏÛ Ó·ÌÓ‚ÎÂÌËfl iPod Software Updater ÏÓÊÌÓ ÒÍ‡˜‡Ú¸ ÔÓ ‡‰ÂÒÛ www.apple.ru/ipod.



46 ëÓ‚ÂÚ˚ Ë ÔÓËÒÍ ÌÂËÒÔ‡‚ÌÓÒÚÂÈ

åÓÈ iPod ÌÂ ‚ÓÒÔÓËÁ‚Ó‰ËÚ ÏÛÁ˚ÍÛ
● ì·Â‰ËÚÂÒ¸, ˜ÚÓ ÔÂÂÍÎ˛˜‡ÚÂÎ¸ Hold Ì‡ıÓ‰ËÚÒfl ‚ ÔÓÎÓÊÂÌËË “‚˚ÍÎ˛˜ÂÌÓ”.
● ÖÒÎË ‚˚ ËÒÔÓÎ¸ÁÛÂÚÂ ÔÛÎ¸Ú Apple iPod Remote, Û·Â‰ËÚÂÒ¸, ˜ÚÓ ÔÂÂÍÎ˛˜‡ÚÂÎ¸ Hold

Ì‡ ÍÓÔÛÒÂ ÔÛÎ¸Ú‡ Ì‡ıÓ‰ËÚÒfl ‚ ÔÓÎÓÊÂÌËË “‚˚ÍÎ˛˜ÂÌÓ”.
● ì·Â‰ËÚÂÒ¸, ˜ÚÓ ÍÓÌÌÂÍÚÓ Ì‡Û¯ÌËÍÓ‚ ‚ÒÚ‡‚ÎÂÌ ‚ „ÌÂÁ‰Ó ‰Ó ÛÔÓ‡.
● èÓ‚Â¸ÚÂ „ÓÏÍÓÒÚ¸ Á‚ÛÍ‡.
● ÖÒÎË ˝ÚÓ ÌÂ ÔÓÏÓ„‡ÂÚ, Ì‡ÊÏËÚÂ ÍÌÓÔÍÛ Play/Pause. ÇÓÒÔÓËÁ‚Â‰ÂÌËÂ Ì‡ ‚‡¯ÂÏ iPod

ÏÓÊÂÚ ·˚Ú¸ ÔËÓÒÚ‡ÌÓ‚ÎÂÌÓ.

èÓÒÎÂ ÔÓ‰ÍÎ˛˜ÂÌËfl iPod Í ÍÓÏÔ¸˛ÚÂÛ ÌË˜Â„Ó ÌÂ ÔÓËÒıÓ‰ËÚ
● ì·Â‰ËÚÂÒ¸, ˜ÚÓ Û ‚‡Ò ÔÓ‰ıÓ‰fl˘ËÈ ÍÓÏÔ¸˛ÚÂ Ë ÛÒÚ‡ÌÓ‚ÎÂÌÓ ÌÂÓ·ıÓ‰ËÏÓÂ ÔÓ„‡ÏÏÌÓÂ

Ó·ÂÒÔÂ˜ÂÌËÂ. (ëÏ. ‡Á‰ÂÎ “óÚÓ ÌÛÊÌÓ, ‰Îfl ÚÓ„Ó ˜ÚÓ·˚ Ì‡˜‡Ú¸” Ì‡ ÒÚ‡ÌËˆÂ 7).
● Ç‡Ï, ‚ÓÁÏÓÊÌÓ, ÔË‰ÂÚÒfl ÔÂÂÁ‡ÔÛÒÚËÚ¸ iPod (ÒÏ. ÒÚ‡ÌËˆÛ 45).
● èÓ‚Â¸ÚÂ ÒÓÂ‰ËÌÂÌËfl Í‡·ÂÎÂÈ. Ç˚Ì¸ÚÂ Ó·‡ ‡Á˙ÂÏ‡ Í‡·ÂÎfl iPod Ë Û·Â‰ËÚÂÒ¸ ‚ ÓÚÒÛÚÒÚ‚ËË

ÔÓÒÚÓÓÌÌËı ÔÂ‰ÏÂÚÓ‚ ‚ ÔÓÚ‡ı FireWire ËÎË USB. èÓÒÎÂ ˝ÚÓ„Ó Ì‡‰ÂÊÌÓ ÔÓ‰ÍÎ˛˜ËÚÂ Í‡·ÂÎË

Ó·‡ÚÌÓ. àÒÔÓÎ¸ÁÛÈÚÂ ÚÓÎ¸ÍÓ Í‡·ÂÎË ‰Îfl iPod ÓÚ Apple.
● ÖÒÎË ˝ÚÓ ÌÂ ÔÓÏÓÊÂÚ, ÔÂÂÁ‡ÔÛÒÚËÚÂ ‚‡¯ ÍÓÏÔ¸˛ÚÂ.
● ÖÒÎË Ë ˝ÚÓ ÌÂ ÔÓÏÓÊÂÚ, ‚‡Ï, ‚ÓÁÏÓÊÌÓ, ÔÓÚÂ·ÛÂÚÒfl ‚ÓÒÒÚ‡ÌÓ‚ËÚ¸ ÔÓ„‡ÏÏÌÓÂ Ó·ÂÒÔÂ˜ÂÌËÂ

iPod. èÓ„‡ÏÏÛ Ó·ÌÓ‚ÎÂÌËfl iPod Software Updater ÏÓÊÌÓ ÒÍ‡˜‡Ú¸ ÔÓ ‡‰ÂÒÛ

www.apple.ru/ipod.
● ÑÓÔÓÎÌËÚÂÎ¸ÌÛ˛ ËÌÙÓÏ‡ˆË˛ ÏÓÊÌÓ ÔÓÎÛ˜ËÚ¸ Ì‡ Ò‡ÈÚÂ ÔÓ‰‰ÂÊÍË iPod ÔÓ ‡‰ÂÒÛ

www.apple.com/support/ipod.
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ì ÏÂÌfl ÌÂ ‡·ÓÚ‡ÂÚ ÔÛÎ¸Ú Apple iPod Remote
● ì·Â‰ËÚÂÒ¸, ˜ÚÓ ÔÂÂÍÎ˛˜‡ÚÂÎ¸ Hold Ì‡ ÍÓÔÛÒÂ ÔÛÎ¸Ú‡ Ì‡ıÓ‰ËÚÒfl ‚ ÔÓÎÓÊÂÌËË “‚˚ÍÎ˛˜ÂÌÓ”.
● ì·Â‰ËÚÂÒ¸, ˜ÚÓ ÍÓÌÌÂÍÚÓ ÔÛÎ¸Ú‡ Ì‡‰ÂÊÌÓ ‚ÒÚ‡‚ÎÂÌ ‚ ‡Á˙ÂÏ Ì‡ iPod, ‡ Ì‡Û¯ÌËÍË Ì‡‰ÂÊÌÓ

ÔÓ‰ÍÎ˛˜ÂÌ˚ Í ÔÛÎ¸ÚÛ.

èÛÎ¸Ú iPod Remote ÔÓÒÚ‡‚ÎflÂÚÒfl Ò ÌÂÍÓÚÓ˚ÏË ÏÓ‰ÂÎflÏË iPod, ‡ Ú‡ÍÊÂ ÏÓÊÂÚ ·˚Ú¸ ÔËÓ·ÂÚÂÌ

ÓÚ‰ÂÎ¸ÌÓ Û ·ËÁÌÂÒ-Ô‡ÚÌÂÓ‚ Ë ‡‚ÚÓËÁËÓ‚‡ÌÌ˚ı ‰ËÎÂÓ‚ Apple. 

åÓÈ iPod ÔÂÂÒ˚Î‡ÂÚ ÏÛÁ˚ÍÛ ÒÎË¯ÍÓÏ ÏÂ‰ÎÂÌÌÓ
● ÖÒÎË ‚˚ ÔÓ‰ÍÎ˛˜‡ÂÚÂ iPod Í ÔÓÚÛ USB 1.1 ‚‡¯Â„Ó ÍÓÏÔ¸˛ÚÂ‡, ÔÓÔÓ·ÛÈÚÂ ËÒÔÓÎ¸ÁÓ‚‡Ú¸ ÔÓÚ

FireWire ËÎË USB 2.0. èÓÚ USB 1.1 ‡·ÓÚ‡ÂÚ ÁÌ‡˜ËÚÂÎ¸ÌÓ ÏÂ‰ÎÂÌÌÂÂ ÔÓÚÓ‚ FireWire

Ë USB 2.0. ÖÒÎË ‚‡¯ ÍÓÏÔ¸˛ÚÂ Windows PC ÌÂ ËÏÂÂÚ ÔÓÚ‡ FireWire ËÎË USB 2.0, ‚˚ ÏÓÊÂÚÂ

ÔËÓ·ÂÒÚË Ë ÛÒÚ‡ÌÓ‚ËÚ¸ ÒÂÚËÙËˆËÓ‚‡ÌÌÛ˛ ‰Îfl ËÒÔÓÎ¸ÁÓ‚‡ÌËfl Ò Windows Í‡ÚÛ Ò

ËÌÚÂÙÂÈÒÓÏ FireWire ËÎË USB 2.0. ÑÎfl ÔÓÎÛ˜ÂÌËfl ‰ÓÔÓÎÌËÚÂÎ¸ÌÓÈ ËÌÙÓÏ‡ˆËË ÔÓÒÂÚËÚÂ

Ò‡ÈÚ www.apple.ru/ipod.

îÓÏ‡Ú˚ ‡Û‰ËÓÙ‡ÈÎÓ‚, ÔÓ‰‰ÂÊË‚‡ÂÏ˚Â iPod
● MP3 (‰Ó 320 Í·/Ò)
● MP3 Ò ÔÂÂÏÂÌÌÓÈ ÒÍÓÓÒÚ¸˛ ·ËÚÓ‚ (VBR)
● AAC
● WAV
● AA (Â˜Â‚˚Â Ù‡ÈÎ˚ Audible)
● AIFF
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èÂÒÌfl ‚ ÙÓÏ‡ÚÂ AIFF ËÎË WAV Á‡ÌËÏ‡ÂÚ ·ÓÎ¸¯Â ÏÂÒÚ‡, ˜ÂÏ Ú‡ ÊÂ ÔÂÒÌfl ‚ ÙÓÏ‡ÚÂ MP3.

äÓ„‰‡ ‚˚ ËÏÔÓÚËÛÂÚÂ ÏÛÁ˚ÍÛ Ò ÍÓÏÔ‡ÍÚ-‰ËÒÍ‡ ÔË ÔÓÏÓ˘Ë iTunes ËÎË MUSICMATCH Jukebox,

ÓÌ‡ ÔÓ ÛÏÓÎ˜‡ÌË˛ ÍÓÌ‚ÂÚËÛÂÚÒfl ‚ ÙÓÏ‡Ú MP3. 

iPod ÌÂ ÔÓ‰‰ÂÊË‚‡ÂÚ ‡Û‰ËÓÙ‡ÈÎ˚ ‚ ÙÓÏ‡ÚÂ MPEG Layer 1 ËÎË MPEG Layer 2.

é·ÌÓ‚ÎÂÌËÂ ÔÓ„‡ÏÏÌÓ„Ó Ó·ÂÒÔÂ˜ÂÌËfl
Apple Â„ÛÎflÌÓ Ó·ÌÓ‚ÎflÂÚ ÔÓ„‡ÏÏÌÓÂ Ó·ÂÒÔÂ˜ÂÌËÂ iPod, ÛÎÛ˜¯‡fl ÔÓËÁ‚Ó‰ËÚÂÎ¸ÌÓÒÚ¸

‡·ÓÚ˚ Ë ‰Ó·‡‚Îflfl ÌÓ‚˚Â ÓÒÓ·ÂÌÌÓÒÚË. êÂÍÓÏÂÌ‰ÛÂÚÒfl ÛÒÚ‡Ì‡‚ÎË‚‡Ú¸ Ì‡ iPod ÔÓÒÎÂ‰Ì˛˛

‚ÂÒË˛ ÔÓ„‡ÏÏÌÓ„Ó Ó·ÂÒÔÂ˜ÂÌËfl. èÓ„‡ÏÏÛ Ó·ÌÓ‚ÎÂÌËfl iPod Software Updater ÏÓÊÌÓ

ÒÍ‡˜‡Ú¸ ÔÓ ‡‰ÂÒÛ www.apple.ru/ipod.

ÖÒÎË ‚˚ Á‡ÔÛÒÍ‡ÂÚÂ ÔÓ„‡ÏÏÛ iPod Software Updater, ‡ ÓÌ‡ ÌÂ Ó·Ì‡ÛÊË‚‡ÂÚ, ˜ÚÓ iPod

ÔÓ‰ÍÎ˛˜ÂÌ Í ÍÓÏÔ¸˛ÚÂÛ, ÔÂÂÁ‡ÔÛÒÚËÚÂ iPod (ÒÏ. ÒÚ‡ÌËˆÛ 45).
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ÑÓÔÓÎÌËÚÂÎ¸Ì‡fl ËÌÙÓÏ‡ˆËfl,
ÒÂ‚ËÒ Ë ÚÂıÌË˜ÂÒÍ‡fl ÔÓ‰‰ÂÊÍ‡

ÑÓÔÓÎÌËÚÂÎ¸Ì‡fl ËÌÙÓÏ‡ˆËfl ÔÓ ‡·ÓÚÂ Ò iPod Ì‡ıÓ‰ËÚÒfl
‚ àÌÚÂÌÂÚÂ Ë ‚ ÒÔ‡‚Ó˜ÌÓÏ Ù‡ÈÎÂ.

êÂÒÛÒ˚ ‚ àÌÚÂÌÂÚÂ
èÓÒÎÂ‰Ìflfl ËÌÙÓÏ‡ˆËfl, Í‡Ò‡˛˘‡flÒfl iPod, ‰ÓÒÚÛÔÌ‡ ÔÓ ‡‰ÂÒÛ www.apple.ru/ipod.

èÓ ‡‰ÂÒÛ www.apple.com/support/ipod Ì‡ıÓ‰ËÚÒfl ÒÂ‚ËÒÌ‡fl ËÌÙÓÏ‡ˆËfl, ËÌÙÓÏ‡ˆËfl

ÚÂıÌË˜ÂÒÍÓÈ ÔÓ‰‰ÂÊÍË, ÏÌÓÊÂÒÚ‚Ó ÒÔÂˆË‡ÎËÁËÓ‚‡ÌÌ˚ı ÙÓÛÏÓ‚, ÒÓ‰ÂÊ‡˘Ëı ËÌÙÓÏ‡ˆË˛

Ó· ÛÒÚÓÈÒÚ‚Â Ë Ó·‡ÚÌÛ˛ Ò‚flÁ¸, ‡ Ú‡ÍÊÂ ÔÓÒÎÂ‰ÌËÂ ‚ÂÒËË ÔÓ„‡ÏÏÌÓ„Ó Ó·ÂÒÔÂ˜ÂÌËfl Apple.

ÑÎfl ÔÓÎÛ˜ÂÌËfl ÔÓ‰‰ÂÊÍË ‚ ‰Û„ÓÈ ÒÚ‡ÌÂ, ÔÓÒÂÚËÚÂ Ò‡ÈÚ www.apple.com/support Ë ‚˚·ÂËÚÂ

‚‡¯Û ÒÚ‡ÌÛ ËÁ ‚ÒÔÎ˚‚‡˛˘Â„Ó ÏÂÌ˛ ‚ÌËÁÛ ˝Í‡Ì‡.

ëÔ‡‚Ó˜Ì˚È Ù‡ÈÎ iPod
● óÚÓ·˚ ÛÁÌ‡Ú¸ ·ÓÎ¸¯Â Ó ‚ÓÁÏÓÊÌÓÒÚflı ÔÓ„‡ÏÏ˚ MUSICMATCH Jukebox (Ì‡ ÍÓÏÔ¸˛ÚÂÂ

Windows PC), Á‡ÔÛÒÚËÚÂ MUSICMATCH Jukebox Ë ‚˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ Help -> MUSICMATCH

Jukebox Help.
● óÚÓ·˚ ÛÁÌ‡Ú¸ ·ÓÎ¸¯Â Ó ‚ÓÁÏÓÊÌÓÒÚflı ÔÓ„‡ÏÏ˚ iTunes (Ì‡ ÍÓÏÔ¸˛ÚÂÂ Macintosh),

Á‡ÔÛÒÚËÚÂ iTunes Ë ‚˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ Help -> iTunes Help.
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● óÚÓ·˚ ÛÁÌ‡Ú¸ ·ÓÎ¸¯Â Ó ‚ÓÁÏÓÊÌÓÒÚflı ÔÓ„‡ÏÏ˚ iSync (‚ Mac OS X), Á‡ÔÛÒÚËÚÂ iSync Ë

‚˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ Help -> iSync Help.
● óÚÓ·˚ ÛÁÌ‡Ú¸ ·ÓÎ¸¯Â Ó ‚ÓÁÏÓÊÌÓÒÚflı ÔÓ„‡ÏÏ˚ iCal (‚ Mac OS X), Á‡ÔÛÒÚËÚÂ iCal Ë ‚˚·ÂËÚÂ

ÔÛÌÍÚ ÏÂÌ˛ Help -> iCal Help.

êÛÍÓ‚Ó‰ÒÚ‚Ó ÔÓ ˝ÍÒÔÎÛ‡Ú‡ˆËË iPod
êÛÍÓ‚Ó‰ÒÚ‚Ó ÔÓ ˝ÍÒÔÎÛ‡Ú‡ˆËË iPod Ú‡ÍÊÂ ÒÓ‰ÂÊËÚÒfl ‚ ‚Ë‰Â Ù‡ÈÎ‡ Ì‡ ÍÓÏÔ‡ÍÚ-‰ËÒÍÂ iPod. äÓ„‰‡

‚˚ ÛÒÚ‡Ì‡‚ÎË‚‡ÂÚÂ ÔÓ„‡ÏÏÌÓÂ Ó·ÂÒÔÂ˜ÂÌËÂ iPod, ˝ÚÓÚ ·ÛÍÎÂÚ ÍÓÔËÛÂÚÒfl Ì‡ ÊÂÒÚÍËÈ ‰ËÒÍ

‚‡¯Â„Ó ÍÓÏÔ¸˛ÚÂ‡.
■ ÑÎfl ÚÓ„Ó ˜ÚÓ·˚ ÓÚÍ˚Ú¸ ÛÍÓ‚Ó‰ÒÚ‚Ó ÔÓ ˝ÍÒÔÎÛ‡Ú‡ˆËË iPod Ì‡ ÍÓÏÔ¸˛ÚÂÂ Macintosh, Á‡ÔÛÒÚËÚÂ

iTunes Ë ‚˚·ÂËÚÂ ÔÛÌÍÚ ÏÂÌ˛ Help -> iTunes Help.
■ ÑÎfl ÚÓ„Ó ˜ÚÓ·˚ ÓÚÍ˚Ú¸ ÛÍÓ‚Ó‰ÒÚ‚Ó ÔÓ ˝ÍÒÔÎÛ‡Ú‡ˆËË iPod Ì‡ ÍÓÏÔ¸˛ÚÂÂ Windows PC,

‚˚·ÂËÚÂ ‚ ÏÂÌ˛ “èÛÒÍ” ÔÛÌÍÚ “ÇÒÂ ÔÓ„‡ÏÏ˚” -> iPod.

É‡‡ÌÚËÈÌÓÂ Ó·ÒÎÛÊË‚‡ÌËÂ
Ç ÒÎÛ˜‡Â ‚ÓÁÌËÍÌÓ‚ÂÌËfl ÌÂËÒÔ‡‚ÌÓÒÚÂÈ ÛÒÚÓÈÒÚ‚‡ ËÎË Â„Ó ÔÓÎÓÏÍË ÒÎÂ‰ÛÈÚÂ ËÌÒÚÛÍˆËflÏ,

Ì‡ıÓ‰fl˘ËÏÒfl ‚ ÒÔ‡‚Ó˜ÌÓÏ Ù‡ÈÎÂ ËÎË ÂÒÛÒ‡ı ‚ àÌÚÂÌÂÚÂ.

ÖÒÎË ˝ÚÓ ÌÂ ÔÓÏÓÊÂÚ, Ó·‡ÚËÚÂÒ¸ Í ÒÂ‚ËÒ-Ô‡ÚÌÂ‡Ï Apple ‰Îfl ÔÓÎÛ˜ÂÌËfl ‡Á˙flÒÌÂÌËÈ ÔÓ

ÔÓ‚Ó‰Û „‡‡ÌÚËÈÌÓ„Ó Ó·ÒÎÛÊË‚‡ÌËfl.

Ç˚flÒÌÂÌËÂ ÒÂËÈÌÓ„Ó ÌÓÏÂ‡ iPod
ëÂËÈÌ˚È ÌÓÏÂ Ì‡ÔÂ˜‡Ú‡Ì Ì‡ Á‡‰ÌÂÈ Ô‡ÌÂÎË iPod. Ç˚ Ú‡ÍÊÂ ÏÓÊÂÚÂ ÛÁÌ‡Ú¸ Â„Ó, ‚˚·‡‚ ÔÛÌÍÚ

ÏÂÌ˛ Settings -> About.
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åÂ˚ ÔÂ‰ÓÒÚÓÓÊÌÓÒÚË Ë ˜ËÒÚÍ‡

éÁÌ‡ÍÓÏ¸ÚÂÒ¸ Ò ËÌÙÓÏ‡ˆËÂÈ Ó ÏÂ‡ı ÔÂ‰ÓÒÚÓÓÊÌÓÒÚË Ë
˜ËÒÚÍÂ iPod.

Ç‡ÊÌ˚Â ÛÍ‡Á‡ÌËfl ÔÓ ·ÂÁÓÔ‡ÒÌÓÒÚË
èË Ì‡ÒÚÓÈÍÂ Ë ËÒÔÓÎ¸ÁÓ‚‡ÌËË iPod ÔÓÏÌËÚÂ ÒÎÂ‰Û˛˘ÂÂ:
● ÔÂÂ‰ ‚ÍÎ˛˜ÂÌËÂÏ ‡‰‡ÔÚÂ‡ iPod Power Adapter ‚ ˝ÎÂÍÚË˜ÂÒÍÛ˛ ÓÁÂÚÍÛ

ÔÓ˜ËÚ‡ÈÚÂ ‚ÌËÏ‡ÚÂÎ¸ÌÓ ËÌÒÚÛÍˆËË ÔÓ ÛÒÚ‡ÌÓ‚ÍÂ;
● ı‡ÌËÚÂ ˝ÚË ËÌÒÚÛÍˆËË ‚ÒÂ„‰‡ ÔÓ·ÎËÁÓÒÚË ‰Îfl ÚÓ„Ó, ˜ÚÓ·˚ ‚˚ ËÎË ‰Û„ËÂ

ÏÓ„ÎË ËÏË ‚ÓÒÔÓÎ¸ÁÓ‚‡Ú¸Òfl;
● ÔË ‡·ÓÚÂ Ò iPod ÒÎÂ‰ÛÈÚÂ ‚ÒÂÏ ËÌÒÚÛÍˆËflÏ Ë ÔÂ‰ÓÒÚÂÂÊÂÌËflÏ.

ÇÌËÏ‡ÌËÂ! èË ÌÂÔ‡‚ËÎ¸ÌÓÏ Ó·‡˘ÂÌËË ˝ÎÂÍÚË˜ÂÒÍÓÂ Ó·ÓÛ‰Ó‚‡ÌËÂ ÏÓÊÂÚ ·˚Ú¸

ÓÔ‡ÒÌÓ. àÒÔÓÎ¸ÁÓ‚‡ÌËÂ ‰‡ÌÌÓ„Ó ÛÒÚÓÈÒÚ‚‡ (ËÎË ÔÓ‰Ó·Ì˚ı) ‰ÓÎÊÌÓ ‚ÒÂ„‰‡ ÓÒÛ˘ÂÒÚ‚ÎflÚ¸Òfl

ÔÓ‰ ÔËÒÏÓÚÓÏ ‚ÁÓÒÎ˚ı. çÂ ÔÓÁ‚ÓÎflÈÚÂ ‰ÂÚflÏ ‡Á·Ë‡Ú¸ ˝ÎÂÍÚË˜ÂÒÍËÂ ÔË·Ó˚

Ë Ë„‡Ú¸ ÒÓ ¯ÌÛ‡ÏË.
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àÁ·Â„‡ÈÚÂ ÔÓ‚ÂÊ‰ÂÌËÈ ÒÎÛı‡

çÂ ËÒÔÓÎ¸ÁÛÈÚÂ iPod ÔË ‚ÓÊ‰ÂÌËË ‡‚ÚÓÏÓ·ËÎfl 
Ç‡ÊÌÓ: ËÒÔÓÎ¸ÁÓ‚‡ÌËÂ Ì‡Û¯ÌËÍÓ‚ ÔË ÛÔ‡‚ÎÂÌËË ‡‚ÚÓÏÓ·ËÎÂÏ ÌÂ ÂÍÓÏÂÌ‰ÛÂÚÒfl Ë Á‡ÔÂ˘ÂÌÓ ‚

ÌÂÍÓÚÓ˚ı ‡ÈÓÌ‡ı. èË ‚ÓÊ‰ÂÌËË ‡‚ÚÓÏÓ·ËÎfl ·Û‰¸ÚÂ ‚ÌËÏ‡ÚÂÎ¸Ì˚ Ë ÓÒÚÓÓÊÌ˚. çÂ ËÒÔÓÎ¸ÁÛÈÚÂ

iPod ‚Ó ‚ÂÏfl ÛÔ‡‚ÎÂÌËfl ‡‚ÚÓÏÓ·ËÎÂÏ Î˛·Ó„Ó ÚËÔ‡ ËÎË ÔË ‚˚ÔÓÎÌÂÌËË Î˛·˚ı ‰Û„Ëı ‰ÂÈÒÚ‚ËÈ,

ÚÂ·Û˛˘Ëı ÔÓÎÌÓÈ ÍÓÌˆÂÌÚ‡ˆËË ‚ÌËÏ‡ÌËfl, ‚ ÒÎÛ˜‡Â, ÂÒÎË ‚˚ ˜Û‚ÒÚ‚ÛÂÚÂ, ˜ÚÓ iPod ÓÚ‚ÎÂÍ‡ÂÚ ‚‡Ò.

äÓÌÌÂÍÚÓ˚ Ë ÔÓÚ˚
● çËÍÓ„‰‡ ÌÂ ËÒÔÓÎ¸ÁÛÈÚÂ ÒËÎÛ ‰Îfl ‚ÒÚ‡‚ÍË ÍÓÌÌÂÍÚÓ‡ ‚ ÔÓÚ. ÖÒÎË ÍÓÌÌÂÍÚÓ ÌÂ Û‰‡ÂÚÒfl ‚ÒÚ‡‚ËÚ¸

‚ ÔÓÚ Ò ‡ÁÛÏÌ˚Ï ÛÒËÎËÂÏ, ÓÌË, ‚ÓÁÏÓÊÌÓ, ÌÂ ÔÓ‰ıÓ‰flÚ ‰Û„ ‰Û„Û. ì·Â‰ËÚÂÒ¸, ˜ÚÓ ÍÓÌÌÂÍÚÓ

ÔÓ‰ıÓ‰ËÚ Í ÔÓÚÛ Ë ˜ÚÓ ‚˚ Ô‡‚ËÎ¸ÌÓ ÓËÂÌÚËÓ‚‡ÎË ÍÓÌÌÂÍÚÓ ÔÓ ÓÚÌÓ¯ÂÌË˛ Í ÔÓÚÛ.

Å‡Ú‡Âfl
● çÂÁ‡ÏÂÌflÂÏ‡fl ‚ÌÛÚÂÌÌflfl ·‡Ú‡Âfl iPod ‰ÓÎÊÌ‡ ‡·ÓÚ‡Ú¸ Ì‡ ÔÓÚflÊÂÌËË ‚ÒÂ„Ó ÔÂËÓ‰‡

‡·ÓÚÓÒÔÓÒÓ·ÌÓÒÚË ÔÓ‰ÛÍÚ‡. ÖÒÎË Û ‚‡Ò ‚ÓÁÌËÍÎË ÔÓ·ÎÂÏ˚ Ò ÔÓ‰ÓÎÊËÚÂÎ¸ÌÓÒÚ¸˛ ‡·ÓÚ˚

·‡Ú‡ÂË, Û·Â‰ËÚÂÒ¸, ˜ÚÓ Ì‡ iPod ÛÒÚ‡ÌÓ‚ÎÂÌ‡ ÔÓÒÎÂ‰Ìflfl ‚ÂÒËfl ÔÓ„‡ÏÏÌÓ„Ó Ó·ÂÒÔÂ˜ÂÌËfl

(ÒÏ. ÒÚ‡ÌËˆÛ 48). ÖÒÎË ˝ÚÓ ÌÂ ÔÓÏÓÊÂÚ, ÔÓÒÂÚËÚÂ Ò‡ÈÚ www.apple.com/support/ipod ‰Îfl

ÔÓÎÛ˜ÂÌËfl ‰ÓÔÓÎÌËÚÂÎ¸ÌÓÈ ËÌÙÓÏ‡ˆËË.
● çÂ Ô˚Ú‡ÈÚÂÒ¸ ‚˚ÌÛÚ¸ ·‡Ú‡Â˛ iPod. éÚ ·‡Ú‡ÂË iPod ÒÎÂ‰ÛÂÚ ËÁ·‡‚ÎflÚ¸Òfl ‚ ÒÓÓÚ‚ÂÚÒÚ‚ËË Ò

ÏÂÒÚÌ˚ÏË Ô‡‚ËÎ‡ÏË Óı‡Ì˚ ÓÍÛÊ‡˛˘ÂÈ ÒÂ‰˚.

ÇÌËÏ‡ÌËÂ! àÒÔÓÎ¸ÁÓ‚‡ÌËÂ Ì‡Û¯ÌËÍÓ‚ ÔË ÔÓ‚˚¯ÂÌÌÓÏ ÛÓ‚ÌÂ „ÓÏÍÓÒÚË ÏÓÊÂÚ

ÔË‚ÂÒÚË Í ÔÓÚÂÂ ÒÎÛı‡. ëÓ ‚ÂÏÂÌÂÏ ‚˚ ÏÓÊÂÚÂ ÔË‚˚ÍÌÛÚ¸ Í ·ÓÎ¸¯ÓÈ „ÓÏÍÓÒÚË,

ÍÓÚÓ‡fl ·Û‰ÂÚ Í‡Á‡Ú¸Òfl ÌÓÏ‡Î¸ÌÓÈ, ÌÓ ‚Â‰ËÚ ‚‡¯ÂÏÛ ÒÎÛıÛ. ìÒÚ‡ÌÓ‚ËÚÂ „ÓÏÍÓÒÚ¸

Ì‡ ·ÂÁÓÔ‡ÒÌ˚È ÛÓ‚ÂÌ¸, ÔÓÍ‡ ˝ÚÓ„Ó ÌÂ ÔÓËÁÓ¯ÎÓ. ÖÒÎË ‚˚ ÒÎ˚¯ËÚÂ Á‚ÓÌ ‚ Û¯‡ı,

ÛÏÂÌ¸¯ËÚÂ „ÓÏÍÓÒÚ¸ ËÎË ÔÂÍ‡ÚËÚÂ ËÒÔÓÎ¸ÁÓ‚‡Ú¸ iPod.
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àÒÔÓÎ¸ÁÓ‚‡ÌËÂ ‡‰‡ÔÚÂ‡ ÔËÚ‡ÌËfl
● àÒÔÓÎ¸ÁÛÈÚÂ ÚÓÎ¸ÍÓ ‡‰‡ÔÚÂ, ‚ıÓ‰fl˘ËÈ ‚ ÍÓÏÔÎÂÍÚ ÔÓÒÚ‡‚ÍË iPod. ÇÌÂ¯ÌÂ ÔÓıÓÊËÂ ‡‰‡ÔÚÂ˚

ÓÚ ‰Û„Ëı ˝ÎÂÍÚÓÌÌ˚ı ÛÒÚÓÈÒÚ‚ ÏÓ„ÛÚ ÔÓ‚Â‰ËÚ¸ iPod.
● Ö‰ËÌÒÚ‚ÂÌÌ˚Ï ÒÔÓÒÓ·ÓÏ ÔÓÎÌÓ„Ó ÓÚÍÎ˛˜ÂÌËfl ‡‰‡ÔÚÂ‡ ÔËÚ‡ÌËfl fl‚ÎflÂÚÒfl Â„Ó ÓÚÍÎ˛˜ÂÌËÂ ÓÚ

ÓÁÂÚÍË.
● ÇÒÂ„‰‡ ÓÒÚ‡‚ÎflÈÚÂ Ò‚Ó·Ó‰ÌÓÂ ÏÂÒÚÓ ‚ÓÍÛ„ ‡‰‡ÔÚÂ‡. çÂ ËÒÔÓÎ¸ÁÛÈÚÂ Â„Ó ‚ ÏÂÒÚ‡ı Ò

Á‡ÚÛ‰ÌÂÌÌ˚Ï ‰ÓÒÚÛÔÓÏ ‚ÓÁ‰Ûı‡ (Ì‡ÔËÏÂ, ‚ ÍÌËÊÌÓÏ ¯Í‡ÙÛ).
● èË ‚ÍÎ˛˜ÂÌËË ËÎË ÓÚÍÎ˛˜ÂÌËË ‡‰‡ÔÚÂ‡ ‰ÂÊËÚÂ Â„Ó ÚÓÎ¸ÍÓ Á‡ Í‡fl Ë ËÁ·Â„‡ÈÚÂ

ÔËÍÓÒÌÓ‚ÂÌËfl Í ÏÂÚ‡ÎÎË˜ÂÒÍËÏ ˜‡ÒÚflÏ ¯ÚÂÔÒÂÎ¸ÌÓÈ ‚ËÎÍË.
● èÂÂ‰ ÔÓ‰ÍÎ˛˜ÂÌËÂÏ ¯ÌÛ‡ FireWire Í ‡‰‡ÔÚÂÛ Û·Â‰ËÚÂÒ¸, ˜ÚÓ ‚ ‡Á˙ÂÏÂ FireWire ÓÚÒÛÚÒÚ‚Û˛Ú

ÔÓÒÚÓÓÌÌËÂ ÔÂ‰ÏÂÚ˚.
● Ä‰‡ÔÚÂ ËÒÚÓ˜ÌËÍ‡ ÔËÚ‡ÌËfl fl‚ÎflÂÚÒfl ‚˚ÒÓÍÓ‚ÓÎ¸ÚÌ˚Ï ÛÒÚÓÈÒÚ‚ÓÏ Ë ÌÂ ‰ÓÎÊÂÌ ÓÚÍ˚‚‡Ú¸Òfl

ÌË ÔË Í‡ÍËı Ó·ÒÚÓflÚÂÎ¸ÒÚ‚‡ı, ‰‡ÊÂ ÂÒÎË iPod ÓÚÍÎ˛˜ÂÌ. ÖÒÎË ‡‰‡ÔÚÂ ÚÂ·ÛÂÚ ÂÏÓÌÚ‡,

Ó·‡ÚËÚÂÒ¸ Í ‡Á‰ÂÎÛ “ÑÓÔÓÎÌËÚÂÎ¸Ì‡fl ËÌÙÓÏ‡ˆËfl, ÒÂ‚ËÒ Ë ÚÂıÌË˜ÂÒÍ‡fl ÔÓ‰‰ÂÊÍ‡” Ì‡

ÒÚ‡ÌËˆÂ 49.
● çËÍÓ„‰‡ ÌÂ ËÒÔÓÎ¸ÁÛÈÚÂ ÒËÎÛ ‰Îfl ÔÓ‰ÍÎ˛˜ÂÌËfl ÍÓÌÌÂÍÚÓ‡ FireWire Í ‡‰‡ÔÚÂÛ. ÖÒÎË

ÔÓ‰ÍÎ˛˜ÂÌËÂ ÌÂ Û‰‡ÂÚÒfl ÓÒÛ˘ÂÒÚ‚ËÚ¸ Ò ‡ÁÛÏÌ˚Ï ÛÒËÎËÂÏ, Ëı ÚËÔ ÌÂ ÒÓÓÚ‚ÂÚÒÚ‚ÛÂÚ ‰Û„ ‰Û„Û.

ì·Â‰ËÚÂÒ¸, ˜ÚÓ ÍÓÌÌÂÍÚÓ ÒÓÓÚ‚ÂÚÒÚ‚ÛÂÚ ‡Á˙ÂÏÛ Ë ˜ÚÓ ÍÓÌÌÂÍÚÓ Ô‡‚ËÎ¸ÌÓ ÓËÂÌÚËÓ‚‡Ì ÔÓ

ÓÚÌÓ¯ÂÌË˛ Í ‡Á˙ÂÏÛ.
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íÂÏÔÂ‡ÚÛÌ˚È ÂÊËÏ ˝ÍÒÔÎÛ‡Ú‡ˆËË Ë ı‡ÌÂÌËfl
● àÒÔÓÎ¸ÁÛÈÚÂ iPod ‚ ‰Ë‡Ô‡ÁÓÌÂ ÚÂÏÔÂ‡ÚÛ 0 – 35° ë.
● ï‡ÌËÚÂ iPod ÔË ÚÂÏÔÂ‡ÚÛÂ -20 – +45° ë.
● Ç ÛÒÎÓ‚Ëflı ˝ÍÒÔÎÛ‡Ú‡ˆËË ÔË ÌËÁÍËı ÚÂÏÔÂ‡ÚÛ‡ı ‚ÂÏfl ‡·ÓÚ˚ ·‡Ú‡ÂË ÏÓÊÂÚ ÒÓÍ‡˘‡Ú¸Òfl.
● çÂ·ÓÎ¸¯ÓÈ Ì‡„Â‚ ÌËÊÌÂÈ ˜‡ÒÚË ÍÓÔÛÒ‡ ÔË ËÒÔÓÎ¸ÁÓ‚‡ÌËË iPod ËÎË ÔÓ‰Á‡fl‰ÍÂ ·‡Ú‡ÂË

fl‚ÎflÂÚÒfl ÌÓÏ‡Î¸Ì˚Ï fl‚ÎÂÌËÂÏ. çËÊÌflfl ˜‡ÒÚ¸ ÍÓÔÛÒ‡ fl‚ÎflÂÚÒfl ÚÂÔÎÓÓÚ‚Ó‰ÓÏ, ÍÓÚÓ˚È

ÓÒÛ˘ÂÒÚ‚ÎflÂÚ ÔÂÂÌÓÒ ÚÂÔÎ‡ ËÁÌÛÚË Ì‡ÛÊÛ.

àÁ·Â„‡ÈÚÂ Ò˚ÓÒÚË

● ï‡ÌËÚÂ iPod Ë ‡‰‡ÔÚÂ ÔËÚ‡ÌËfl ‚‰‡ÎË ÓÚ ÊË‰ÍÓÒÚÂÈ Ë Ëı ËÒÚÓ˜ÌËÍÓ‚ (Ì‡ÔËÏÂ, Ì‡ÔËÚÍÓ‚,

‡ÍÓ‚ËÌ, ‚‡ÌÌ, ‰Û¯Â‚˚ı Í‡·ËÌ Ë Ú. ‰.).
● èÂ‰Óı‡ÌflÈÚÂ iPod Ë ‡‰‡ÔÚÂ ÔËÚ‡ÌËfl ÓÚ ÔÓÔ‡‰‡ÌËfl ‰ÓÊ‰fl Ë ‰Û„Ëı ÊË‰ÍÓÒÚÂÈ, ÔflÏ˚ı

ÒÓÎÌÂ˜Ì˚ı ÎÛ˜ÂÈ, Ì‡„Â‚‡ÚÂÎ¸Ì˚ı ÔË·ÓÓ‚.
● èÓÒÚ‡‡ÈÚÂÒ¸ ËÁ·ÂÊ‡Ú¸ ÔÓÔ‡‰‡ÌËfl ÔË˘Ë Ë Ì‡ÔËÚÍÓ‚ Ì‡ iPod Ë Â„Ó ‡‰‡ÔÚÂ ÔËÚ‡ÌËfl. ÖÒÎË ˝ÚÓ

ÔÓËÁÓ¯ÎÓ, ÓÚÍÎ˛˜ËÚÂ iPod Ë Ó˜ËÒÚËÚÂ Â„Ó.

ÇÌËÏ‡ÌËÂ! ÇÓ ËÁ·ÂÊ‡ÌËÂ Û‰‡‡ ÚÓÍÓÏ ÌÂ ËÒÔÓÎ¸ÁÛÈÚÂ iPod ‚·ÎËÁË ‚Ó‰˚

ËÎË ‚ ÔÓÏÂ˘ÂÌËflı Ò ÔÓ‚˚¯ÂÌÌÓÈ ‚Î‡ÊÌÓÒÚ¸˛.
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çÂ ÔÓËÁ‚Ó‰ËÚÂ ÂÏÓÌÚ Ò‡ÏÓÒÚÓflÚÂÎ¸ÌÓ

ÑÎfl ÔÓÎÛ˜ÂÌËfl ÒÂ‚ËÒÌÓÈ ËÌÙÓÏ‡ˆËË ÒÏ. ‡Á‰ÂÎ “ÑÓÔÓÎÌËÚÂÎ¸Ì‡fl ËÌÙÓÏ‡ˆËfl, ÒÂ‚ËÒ Ë

ÚÂıÌË˜ÂÒÍ‡fl ÔÓ‰‰ÂÊÍ‡” Ì‡ ÒÚ‡ÌËˆÂ 49.

óËÒÚÍ‡
èË ˜ËÒÚÍÂ ÔÓ‚ÂıÌÓÒÚË iPod Ë Â„Ó ÍÓÏÔÓÌÂÌÚÓ‚ ÒÎÂ‰ÛÈÚÂ ÒÎÂ‰Û˛˘ËÏ Ô‡‚ËÎ‡Ï:
● Û·Â‰ËÚÂÒ¸ ‚ ÚÓÏ, ˜ÚÓ iPod ÓÚÍÎ˛˜ÂÌ ÓÚ ÒÂÚË Ë ÍÓÏÔ¸˛ÚÂ‡;
● ËÒÔÓÎ¸ÁÛÈÚÂ ‚Î‡ÊÌÛ˛ ·ÂÁ‚ÓÒÓ‚Û˛ ÚÍ‡Ì¸. àÁ·Â„‡ÈÚÂ ÔÓÔ‡‰‡ÌËfl ‚Î‡„Ë ‚ ÓÚ‚ÂÒÚËfl;
● ÌÂ ËÒÔÓÎ¸ÁÛÈÚÂ ‡˝ÓÁÓÎË, ‡ÒÚ‚ÓËÚÂÎË, ÒÔËÚ Ë ‡·‡ÁË‚˚.

é·‡˘ÂÌËÂ
iPod ÏÓÊÂÚ ·˚Ú¸ ÔÓ‚ÂÊ‰ÂÌ ‚ ÂÁÛÎ¸Ú‡ÚÂ ÌÂÔ‡‚ËÎ¸ÌÓ„Ó ı‡ÌÂÌËfl ËÎË Ó·‡˘ÂÌËfl. çÂ ÓÌflÈÚÂ

ÛÒÚÓÈÒÚ‚Ó ÔË ËÒÔÓÎ¸ÁÓ‚‡ÌËË ËÎË Ú‡ÌÒÔÓÚËÓ‚ÍÂ.

ÇÌËÏ‡ÌËÂ! çÂ Ô˚Ú‡ÈÚÂÒ¸ ÓÚÍ˚‚‡Ú¸ iPod ËÎË ‡‰‡ÔÚÂ ÔËÚ‡ÌËfl, ‡Á·Ë‡Ú¸ Ëı

ËÎË ‚˚ÌËÏ‡Ú¸ ·‡Ú‡Â˛. Ç˚ ËÒÍÛÂÚÂ ÔÓÎÛ˜ËÚ¸ Û‰‡ ÚÓÍÓÏ Ë ÎË¯ËÚ¸Òfl „‡‡ÌÚËË. ÇÌÛÚË

ÛÒÚÓÈÒÚ‚ ÌÂÚ ˜‡ÒÚÂÈ, ÍÓÚÓ˚Â ÏÓ„ÛÚ ·˚Ú¸ ÓÚÂÏÓÌÚËÓ‚‡Ì˚ ÔÓÎ¸ÁÓ‚‡ÚÂÎÂÏ.
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àÌÙÓÏ‡ˆËfl Ó ÒÓÓÚ‚ÂÚÒÚ‚ËË
ÍÓÏÏÛÌËÍ‡ˆËÓÌÌ˚Ï Ô‡‚ËÎ‡Ï

ëÓÓÚ‚ÂÚÒÚ‚ËÂ Ô‡‚ËÎ‡Ï îÂ‰Â‡Î¸ÌÓÈ
ÍÓÏËÒÒËË ÔÓ Ò‚flÁË (FCC)
Ñ‡ÌÌÓÂ Ó·ÓÛ‰Ó‚‡ÌËÂ ÒÓÓÚ‚ÂÚÒÚ‚ÛÂÚ ˜‡ÒÚË
15 Ô‡‚ËÎ FCC. îÛÌÍˆËÓÌËÓ‚‡ÌËÂ
Ó„‡ÌË˜Ë‚‡ÂÚÒfl ÒÎÂ‰Û˛˘ËÏË ‰‚ÛÏfl
ÛÒÎÓ‚ËflÏË: (1) Ñ‡ÌÌÓÂ Ó·ÓÛ‰Ó‚‡ÌËÂ ÌÂ
ÏÓÊÂÚ ‚˚Á˚‚‡Ú¸ ‚Â‰Ì˚Â ÔÓÏÂıË, Ë (2)
Ñ‡ÌÌÓÂ Ó·ÓÛ‰Ó‚‡ÌËÂ ÔÓ‰‚ÂÊÂÌÓ Î˛·˚Ï
ÔÓÏÂı‡Ï, ‚ÍÎ˛˜‡fl ÔÓÏÂıË, ÍÓÚÓ˚Â ÏÓ„ÛÚ
ÔË‚ÂÒÚË Í ÌÂÊÂÎ‡ÚÂÎ¸Ì˚Ï ÔÓÒÎÂ‰ÒÚ‚ËflÏ.
é·‡ÚËÚÂÒ¸ Í ËÌÒÚÛÍˆËË, ÂÒÎË ÂÒÚ¸
ÔÓ‰ÓÁÂÌËfl Ó Ì‡ÎË˜ËË ÔÓÏÂı ‚ ÔËÂÏÂ
‡‰ËÓ- ËÎË ÚÂÎÂ‚ËÁËÓÌÌ˚ı ÒË„Ì‡ÎÓ‚.

ê‡‰ËÓ- Ë ÚÂÎÂ‚ËÁËÓÌÌ˚Â ÔÓÏÂıË
ç‡ÒÚÓfl˘ÂÂ ÍÓÏÔ¸˛ÚÂÌÓÂ Ó·ÓÛ‰Ó‚‡ÌËÂ
„ÂÌÂËÛÂÚ, ËÒÔÓÎ¸ÁÛÂÚ, ‡ Ú‡ÍÊÂ ÒÔÓÒÓ·ÌÓ
ËÁÎÛ˜‡Ú¸ ˝ÌÂ„Ë˛ Ì‡ ‡‰ËÓ˜‡ÒÚÓÚ‡ı. ÖÒÎË
Ó·ÓÛ‰Ó‚‡ÌËÂ ÛÒÚ‡ÌÓ‚ÎÂÌÓ Ë ËÒÔÓÎ¸ÁÛÂÚÒfl
ÌÂ ‚ ÒÚÓ„ÓÏ ÒÓÓÚ‚ÂÚÒÚ‚ËË Ò ËÌÒÚÛÍˆËflÏË
Apple, ÓÌÓ ÏÓÊÂÚ ‚˚Á‚‡Ú¸ ÔÓÏÂıË ‰Îfl
‡‰ËÓ- Ë ÚÂÎÂÒ‚flÁË.

Ñ‡ÌÌÓÂ Ó·ÓÛ‰Ó‚‡ÌËÂ ·˚ÎÓ ÔÓ‚ÂÂÌÓ Ë
Ì‡È‰ÂÌÓ ÒÓÓÚ‚ÂÚÒÚ‚Û˛˘ËÏ ÛÒÚ‡ÌÓ‚ÎÂÌÌ˚Ï
ÔÂ‰ÂÎ‡Ï ‰Îfl ˆËÙÓ‚Ó„Ó ÛÒÚÓÈÒÚ‚‡ ÍÎ‡ÒÒ‡ Ç
‚ ÒÓÓÚ‚ÂÚÒÚ‚ËË Ò ˜‡ÒÚ¸˛ 15 Ô‡‚ËÎ
îÂ‰Â‡Î¸ÌÓÈ ÍÓÏËÒÒËË ÔÓ Ò‚flÁË (FCC). ùÚË
ÔÂ‰ÂÎ˚ ‡ÒÒ˜ËÚ‡Ì˚ Ì‡ ‡‰ÂÍ‚‡ÚÌÓÂ

ÔÂ‰Óı‡ÌÂÌËÂ ÓÚ ‚Â‰Ì˚ı ÔÓÏÂı ‚ ÊËÎ˚ı
ÔÓÏÂ˘ÂÌËflı. íÂÏ ÌÂ ÏÂÌÂÂ, ÓÚÒÛÚÒÚ‚ËÂ
ÔÓÏÂı ‚ Í‡Ê‰ÓÏ ÓÚ‰ÂÎ¸ÌÓÏ ÒÎÛ˜‡Â
ÛÒÚ‡ÌÓ‚ÍË ÛÍ‡Á‡ÌÌÓ„Ó Ó·ÓÛ‰Ó‚‡ÌËfl ÌÂ
„‡‡ÌÚËÛÂÚÒfl.

Ç˚ ÏÓÊÂÚÂ ÛÒÚ‡ÌÓ‚ËÚ¸, ‚˚Á˚‚‡ÂÚ ÎË ‚‡¯‡
ÍÓÏÔ¸˛ÚÂÌ‡fl ÒËÒÚÂÏ‡ ÔÓÏÂıË, ‚˚ÍÎ˛˜Ë‚
ÂÂ. ÖÒÎË ÔÓÏÂıË ÔÂÍ‡ÚËÎËÒ¸, ‚ÓÁÏÓÊÌÓ,
ÓÌË ·˚ÎË ‚˚Á‚‡Ì˚ ÍÓÏÔ¸˛ÚÂÓÏ ËÎË Ó‰ÌËÏ
ËÁ ÔÂËÙÂËÈÌ˚ı ÛÒÚÓÈÒÚ‚.

ÖÒÎË ‚‡¯‡ ÍÓÏÔ¸˛ÚÂÌ‡fl ÒËÒÚÂÏ‡ ‚˚Á˚‚‡ÂÚ
ÔÓÏÂıË ‰Îfl ‡‰ËÓ- ËÎË ÚÂÎÂ‚ËÁËÓÌÌÓ„Ó
ÔËÂÏ‡, ÔÓÔ˚Ú‡ÈÚÂÒ¸ ÛÒÚ‡ÌËÚ¸ Ì‡‚Ó‰ËÏ˚Â
ÔÓÏÂıË ÔÛÚÂÏ ÒÎÂ‰Û˛˘Ëı ÏÂ:
● ÔÂÂÓËÂÌÚËÛÈÚÂ ËÎË ÔÂÂÏÂÒÚËÚÂ

ÔËÂÏÌÛ˛ ‡ÌÚÂÌÌÛ;
● ÔÓÏÂÒÚËÚÂ ÍÓÏÔ¸˛ÚÂ Ò ‰Û„ÓÈ ÒÚÓÓÌ˚

ÚÂÎÂ‚ËÁÓ‡ ËÎË ‡‰ËÓÔËÂÏÌËÍ‡;
● Û‚ÂÎË˜¸ÚÂ ‰ËÒÚ‡ÌˆË˛ ÏÂÊ‰Û ÍÓÏÔ¸˛ÚÂÓÏ

Ë ÔËÂÏÌËÍÓÏ;
● ‚ÍÎ˛˜ËÚÂ Ó·ÓÛ‰Ó‚‡ÌËÂ ‚ ÓÁÂÚÍÛ, Í

ÍÓÚÓÓÈ ÌÂ ÔÓ‰ÍÎ˛˜‡ÂÚÒfl ÔËÂÏÌËÍ.
(íÓ ÂÒÚ¸ Û·Â‰ËÚÂÒ¸, ˜ÚÓ ÍÓÏÔ¸˛ÚÂ Ë
ÚÂÎÂ‚ËÁÓ ËÎË ‡‰ËÓÔËÂÏÌËÍ
ÔÓ‰ÍÎ˛˜ÂÌ˚ Í Û˜‡ÒÚÍ‡Ï ˝ÎÂÍÚË˜ÂÒÍÓÈ
ˆÂÔË, ÍÓÌÚÓÎËÛÂÏ˚Ï ‡ÁÌ˚ÏË
‡‚ÚÓÏ‡ÚË˜ÂÒÍËÏË ‚˚ÍÎ˛˜‡ÚÂÎflÏË ËÎË
ÔÓ·Í‡ÏË.)

ÖÒÎË ÌÂÓ·ıÓ‰ËÏÓ, ÔÓÍÓÌÒÛÎ¸ÚËÛÈÚÂÒ¸ Ò
ÒÂÚËÙËˆËÓ‚‡ÌÌ˚Ï ÔÓÒÚ‡‚˘ËÍÓÏ ÛÒÎÛ„
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Apple ËÎË ÙËÏÓÈ Apple. é·‡ÚËÚÂÒ¸ Í
ËÌÙÓÏ‡ˆËË Ó ÒÂ‚ËÒÂ Ë ÚÂıÌË˜ÂÒÍÓÈ
ÔÓ‰‰ÂÊÍÂ, ‚ıÓ‰fl˘ÂÈ ‚ ÍÓÏÔÎÂÍÚ ÔÓÒÚ‡‚ÍË
ÔÓ‰ÛÍÚ‡ Apple. àÎË ÔÓÒÓ‚ÂÚÛÈÚÂÒ¸ Ò
ÓÔ˚ÚÌ˚Ï ‡‰ËÓÚÂÎÂÏÂı‡ÌËÍÓÏ.

Ç‡ÊÌÓ: ËÁÏÂÌÂÌËÂ Ë ÏÓ‰ËÙËÍ‡ˆËfl ‰‡ÌÌÓ„Ó
ÔÓ‰ÛÍÚ‡, ÌÂ Ò‡ÌÍˆËÓÌËÓ‚‡ÌÌ˚Â ÙËÏÓÈ
Apple Computer Inc., ÏÓ„ÛÚ ÔË‚ÂÒÚË Í
Ì‡Û¯ÂÌË˛ ÒÓÓÚ‚ÂÚÒÚ‚Ëfl ÚÂ·Ó‚‡ÌËflÏ EMC
Ë ÎË¯ËÚ¸ ‚‡Ò Ô‡‚‡ ‡·ÓÚ˚ Ò ÔÓ‰ÛÍÚÓÏ.

Ñ‡ÌÌ˚È ÔÓ‰ÛÍÚ ·˚Î ÔÓÚÂÒÚËÓ‚‡Ì Ì‡
ÒÓÓÚ‚ÂÚÒÚ‚ËÂ ÚÂ·Ó‚‡ÌËflÏ EMC ‚ ÛÒÎÓ‚Ëflı
ËÒÔÓÎ¸ÁÓ‚‡ÌËfl ÔÂËÙÂËÈÌ˚ı ÛÒÚÓÈÒÚ‚
Apple Ë ˝Í‡ÌËÓ‚‡ÌÌ˚ı Í‡·ÂÎÂÈ Ë
ÍÓÌÌÂÍÚÓÓ‚ Apple. ÑÎfl ÛÏÂÌ¸¯ÂÌËfl
‚ÂÓflÚÌÓÒÚË ‚˚ÁÓ‚‡ ÔÓÏÂı ‰Îfl ‡‰ËÓ ËÎË
ÚÂÎÂ‚ËÁËÓÌÌÓ„Ó ÔËÂÏ‡ Ë ‚ ‰Û„Ëı
˝ÎÂÍÚÓÌÌ˚ı ÔË·Ó‡ı ÌÛÊÌÓ ËÒÔÓÎ¸ÁÓ‚‡Ú¸
ÔÂËÙÂËÈÌ˚Â ÛÒÚÓÈÒÚ‚‡ Apple Ë
˝Í‡ÌËÓ‚‡ÌÌ˚Â Í‡·ÂÎË Ë ÍÓÌÌÂÍÚÓ˚
Apple. Ç˚ ÏÓÊÂÚÂ ÔËÓ·ÂÒÚË
ÔÂËÙÂËÈÌ˚Â ÛÒÚÓÈÒÚ‚‡ Apple Ë
ÒÓÓÚ‚ÂÚÒÚ‚Û˛˘ËÂ ˝Í‡ÌËÓ‚‡ÌÌ˚Â Í‡·ÂÎË Ë
ÍÓÌÌÂÍÚÓ˚ Û ÒÂÚËÙËˆËÓ‚‡ÌÌÓ„Ó ‰ËÎÂ‡
Apple. ÑÎfl ÔËÓ·ÂÚÂÌËfl Ó·ÓÛ‰Ó‚‡ÌËfl
‰Û„Ëı ÙËÏ Ó·‡˘‡ÈÚÂÒ¸ Í
ÒÓÓÚ‚ÂÚÒÚ‚Û˛˘ÂÏÛ ÔÓËÁ‚Ó‰ËÚÂÎ˛ ËÎË
‰ËÎÂÛ. éÚ‚ÂÚÒÚ‚ÂÌÌ‡fl ÒÚÓÓÌ‡ (Ó·‡˘‡ÈÚÂÒ¸
ÚÓÎ¸ÍÓ ÔÓ ‚ÓÔÓÒ‡Ï ÒÓÓÚ‚ÂÚÒÚ‚Ëfl Ô‡‚ËÎ‡Ï
FCC): Apple Computer Inc.

Product Compliance, 1 infinite Loop M/S 26-A,
Cupertino, CA 95014-2084, 408-974-2000.

ëÓÓÚ‚ÂÚÒÚ‚ËÂ ÚÂ·Ó‚‡ÌËflÏ Í‡Ì‡‰ÒÍÓÈ
ËÌ‰ÛÒÚËË
Ñ‡ÌÌÓÂ ÛÒÚÓÈÒÚ‚Ó ÍÎ‡ÒÒ‡ B ÒÓÓÚ‚ÂÚÒÚ‚ÛÂÚ
‚ÒÂÏ ÚÂ·Ó‚‡ÌËflÏ, ÔÂ‰˙fl‚ÎflÂÏ˚Ï Í
‚˚Á˚‚‡˛˘ÂÏÛ ÔÓÏÂıË Ó·ÓÛ‰Ó‚‡ÌË˛ ‚
ä‡Ì‡‰Â.

ëÓÓÚ‚ÂÚÒÚ‚ËÂ ÚÂ·Ó‚‡ÌËflÏ VCCI Class B

Ö‚ÓÔÂÈÒÍÓÂ ëÓÓ·˘ÂÒÚ‚Ó
ëÓÓÚ‚ÂÚÒÚ‚ÛÂÚ Â‚ÓÔÂÈÒÍËÏ ‰ËÂÍÚË‚‡Ï
72/23/EEC Ë 89/336/EEC.

© 2003 Apple Computer Inc. ÇÒÂ Ô‡‚‡ Á‡˘Ë˘ÂÌ˚.

Apple, ÎÓ„ÓÚËÔ Apple, Apple Store, FireWire, ÎÓ„ÓÚËÔ
FireWire, iTunes, Mac, ÎÓ„ÓÚËÔ Mac Ë Macintosh
fl‚Îfl˛ÚÒfl ÚÓ„Ó‚˚ÏË Ï‡Í‡ÏË Apple Computer Inc.,
Á‡Â„ËÒÚËÓ‚‡ÌÌ˚ÏË ‚ ëòÄ Ë ‰Û„Ëı ÒÚ‡Ì‡ı.

Finder, iCal Ë iPod fl‚Îfl˛ÚÒfl ÚÓ„Ó‚˚ÏË Ï‡Í‡ÏË Apple
Computer Inc.

MUSICMATCH fl‚ÎflÂÚÒfl ÚÓ„Ó‚ÓÈ Ï‡ÍÓÈ MUSIC-
MATCH Inc. MUSICMATCH Jukebox fl‚ÎflÂÚÒfl ÚÓ„Ó‚ÓÈ
Ï‡ÍÓÈ MUSICMATCH Inc. 
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